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About CallPilot

This chapter introduces CallPilot, the powerful multimedia messaging syste
from Nortel Networks. CallPilot offers a single solution for managing many 
types of information, including voice mail, fax-mail, e-mail, telephone calls, 
conferencing, calendars, directories, and call logs.

CallPilot enables you to get all the information you need from one source, 
whether through display-based telephone sets, your wireless set, your Win
desktop computer, a speech recognition interface, or another personal 
communications device. 

In this chapter 
About this guide 13

Finding your way around CallPilot 35
Integrated AMIS Networking Implementation and Administration Guide 11
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Overview

Introduction
The Integrated AMIS Networking Implementation and Administration Guide 
provides the information and procedures that are necessary to implement 
Integrated AMIS Networking.

Assumptions
This guide assumes that the Meridian Application Server has been correctl
installed and is operational. If the application has not been installed, then in
it before proceeding. For installation instructions, refer to the hardware 
installation guide appropriate to your server type.

If the server has been installed but is not operational, refer to the Maintenance 
and Diagnostics Guide for information on troubleshooting your system.
14 CallPilot
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Skills you need

Introduction
You need certain skills and knowledge to use this guide effectively.

Nortel Networks product knowledge
Knowledge of, or experience with, the following Nortel Networks products w
assist you:

■ Meridian 1

■ Meridian Mail

PC experience or knowledge
Knowledge of, or experience with, the following PC products will be of 
assistance. This guide does not document the following functionality:

■ Microsoft Windows NT

■ Microsoft Windows 95

Other experience or knowledge
Other types of experience or knowledge that may be of use include the 
following:

■ network management

■ client-server systems

■ flowcharting
Integrated AMIS Networking Implementation and Administration Guide 15
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Related information products

Introduction
Following is a list of all CallPilot technical documents. The CD-ROM that yo
receive with your system contains these guides, enabling you to search the 
suite of documentation online. If you prefer, you can print out entire guides,
parts of a guide. 

You order copies of these documents using the NTP numbers or P0 numbe
provided. 

Planning and migration
These guides are used before CallPilot is installed to help you plan your sy
and, if you have a Meridian Mail system, migrate to CallPilot. 

Document Title NTP number

Planning and Engineering Guide 555-7101-101

Meridian Mail to CallPilot Migration Guide 555-7101-801
16 CallPilot
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Installation guides
These guides describe how to install server hardware and CallPilot softwar

Administration and feature guides
These guides describe how to configure CallPilot, administer and maintain 
and use its features. 

Document Title

NTP number
or
P0 number

Meridian Application Server 200i Installation Guide P0884895

Meridian Application Server 702t Installation and 
Maintenance Guide

P0884909

Meridian Application Server 1001rp Installation and 
Maintenance Guide

P0886776

Software Installation Guide 555-7101-200

Document Title NTP number

Basic Administration Guide 555-7101-300

Advanced Administration Guide - 
volume 1

555-7101-301

Advanced Administration Guide - 
volume 2

555-7101-301

Reporter Guide 555-7101-310

Application Builder Guide 555-7101-325
Integrated AMIS Networking Implementation and Administration Guide 17
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Networking guides
These guides describe how to plan, install, set up, and troubleshoot networ
services. 

Maintenance and troubleshooting guides
These guides describe how to maintain your system once it is in service and
you troubleshoot operational problems.  

End user guides
These guides are intended for end users of CallPilot, such as telephone se
and desktop messaging users. 

Document Title NTP number

Networking Planning Guide 555-7101-100

NMS Implementation and Administration Guide 555-7101-302

AMIS Networking Implementation and Administration 
Guide

555-7101-303

Enterprise Networking Implementation and 
Administration Guide

555-7101-304

Integrated AMIS Networking Implementation and 
Administration Guide

555-7101-305

VPIM Networking Implementation and Administration 
Guide

555-7101-306

Document Title NTP number

Maintenance and Diagnostics Guide 555-7101-500

Support Tools Guide 555-7101-800

Document Title P0 number

Speech Activated Messaging User Guide P0886127
18 CallPilot
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CD ROM
The CD-ROM contains all the listed documents, except the end user guides

Multimedia Messaging Quick Reference Card P0886128

Multimedia Messaging User Guide P0886140

Desktop Messaging for Microsoft Exchange Guide P0886141

Desktop Messaging for Lotus Notes Guide P0886142

Internet Messaging Guide P0886143

Document Title Order number

CallPilot Technical Documentation CD NTRG19AA

A0742811

Document Title P0 number
Integrated AMIS Networking Implementation and Administration Guide 19
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Using the online reference guides

Introduction
The online reference guides contain the same procedures and context-sen
information that you find in the online Help. However, the guides contain 
additional information not included in the online Help. These guides have 
overview sections that describe concepts and features and provide other 
CallPilot information.

To print an online guide, see Printing an online guide on page 28.

The online guides
The following reference guides are available online.

■ Overview Guide

■ Advanced Administration Guide

■ Application Builder Guide

■ Reporter Guide

■ Networking guides

● Networking Planning Guide

● AMIS Networking Implementation and Administration Guide

● Integrated AMIS Networking Implementation and Administration Gu

● Enterprise Networking Implementation and Administration Guide

● VPIM Networking Implementation and Administration Guide

● NMS Implementation and Administration Guide
20 CallPilot
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To access the online guides

1 On the Help menu, click Reference Guides.

Attention:  If you see the following error message, Adobe Acrobat was not 
installed during the MAS software installation. Refer to the Software 
Installation Guide for the Acrobat Installation procedure.
Integrated AMIS Networking Implementation and Administration Guide 21
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2 Click the document you want to open.

Result: The front cover is displayed. Select a chapter from the front cover 
or from the bookmarks displayed in the left frame.

Navigating the online guides
There are several ways to navigate through the guides and to find specific to 
22 CallPilot
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Bookmarks
Bookmarks are displayed on the left-hand side of each document. To go to
specific part of the document, such as a chapter or section, click the bookm
 

Integrated AMIS Networking Implementation and Administration Guide 23
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Using hypertext links
Once you find the chapter or section you are interested in, use hypertext lin
navigate within the chapter and document.

Links appear as blue underlined text.
 

24 CallPilot
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When you click a link, the selected topic is displayed.
Integrated AMIS Networking Implementation and Administration Guide 25
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Using the document button bar
The online guides have a button bar at the top of each page to help you ge
around quickly. 

On each page you can use the following buttons:  

Using Acrobat Reader commands
Adobe Acrobat Reader also has features to help you work through the docum
You can learn more about Reader by accessing its online guide from the Ac
Reader Help menu.

Here are some of the more common commands:

Button Description

home Goes to the cover page of the current guide.

help Provides tips on how to use the online guides.

contents Goes to the table of contents for the current guide.

index Goes to the index for the current guide.

back Goes to the previous page in the guide.

next Goes to the next page in the guide.

 Function Description

. Goes back to the last view and forward to the next view

. Goes to the previous page and to the next page in the 
document.
26 CallPilot
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Searching for information
You can use the Acrobat Search tool to find specific information. This tool 
enables you to find all instances of a word or phrase. You can search eithe
current guide or all the online guides.  

. Goes to the first page of the document and to the last pa
of the document.

Search function Description

. 

Searches the current document for all instances of the 
word or phrase you type. Goes to the first page that has
least one instance of the word or phrase, and highlights
your choice.

. 

Searches all the online guides for the word or phrase yo
type. Displays a list of the guides containing the search
word or phrase. The guide you select opens to the first 
page that has at least one instance of the word or phras
and highlights your choice.

. 

Goes to the next instance of the word or phrase.

. 

Goes to the previous instance of the word or phrase.

 Function Description
Integrated AMIS Networking Implementation and Administration Guide 27
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Printing an online guide
For best results when you print an online guide, use a Postscript-compatibl
printer capable of 600 dpi output. If a Postscript printer is not available, use
Adobe Acrobat 3.0 (not Acrobat 3.01). Acrobat 3.0 is installed by default wi
the CallPilot 1.0 Administration client software. It is also available from http
www.adobe.com.

To set print properties for an online guide

1 In Acrobat Reader, open the file for the online guide.

2 From the File menu, select Print Setup...

3 In the Print Setup dialog box, select Properties.

4 Select the Graphics tab.

5 Select Resolution, and then select 600 dpi.

6 Click OK until you exit from all the dialog boxes.

Note: Your screens should print out legibly, even on a non-Postscript 
printer.

To print an online guide

1 From the File menu, select Print.

2 Indicate the page range.

3 Click OK.
28 CallPilot
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Contacting technical support

Introduction
Contact your distributor’s technical support organization to get help with 
troubleshooting your system.

Before contacting Technical Support, ensure that you have the necessary 
information on hand.

Information about your server
Technical Support may ask for the following information, which is displayed
the Server Settings window: 

■ server version number

■ release number

■ serial number (if you have this number available)

Getting there  Nortel SMI > Meridian Application Server > System 
Administration

To view server settings

1 Double-click System Configuration.

2 Double-click Server Settings.
Integrated AMIS Networking Implementation and Administration Guide 29



About CallPilot  Standard 1.0

t part, 

nd 

e 
Identifying Field Replacement Units (FRUs)
If you have diagnosed a hardware problem and need to order a replacemen
you must be able to identify the part.

For more information about running diagnostics on hardware components a
identifying field replacement units, see the Maintenance and Diagnostics Guide.

Contacting Nortel Networks
If you have comments or suggestions for improving CallPilot and its 
documentation, Nortel Networks would like to hear from you. Please see th
following address:

http://www.nortelnetworks.com/callpilot_feedback
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How this guide is organized

Introduction
The Integrated AMIS Networking Implementation and Administration Guide is 
organized in the sequence of tasks required to successfully implement Integ
AMIS Networking for CallPilot. Start at the beginning of the guide and work
your way through it until all required tasks are completed.

Contents
This guide contains the following chapters.

Chapter title Description

Chapter 1, About CallPilot This chapter describes how to work with the
CallPilot interface and how to use this guide

Chapter 2, Getting started This chapter provides an overview of 
Integrated AMIS Networking.

This chapter describes the features support
by Integrated AMIS Networking and how 
Integrated AMIS Networking works.

This chapter also provides a high-level 
overview of the tasks that are performed 
during implementation.

Chapter 3, Gathering information This chapter explains how to gather the 
information required to implement 
Integrated AMIS Networking.

Chapter 4, Configuring the switch for 
Integrated AMIS Networking

This chapter explains how to configure the 
switch for Integrated AMIS Networking.

Chapter 5, Configuring CallPilot for 
Integrated AMIS Networking

This chapter describes how to configure 
CallPilot for Integrated AMIS Networking.

This chapter describes every box that must b
completed and provides detailed procedures
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Chapter 6, Adding sites to Integrated 
AMIS Networking

This chapter describes how to configure the
local site. This chapter also describes how t
add and configure every site in the messagin
network that uses Integrated AMIS 
Networking to exchange messages with loca
sites.

This chapter describes every box that must b
completed and provides detailed procedures

Chapter 7, Testing and backing up 
Integrated AMIS Networking

This chapter describes how to test the 
implementation of Integrated AMIS 
Networking to ensure that it is properly 
configured. This chapter also describes how
to perform a backup of the system.

Chapter 8, Maintaining Integrated AMIS 
Networking

This chapter explains how to perform both 
regularly scheduled maintenance tasks and
as-required maintenance tasks.

Chapter 9, Troubleshooting Integrated 
AMIS Networking

This chapter provides information to identify
and solve problems with Integrated AMIS 
Networking.

Chapter title Description
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Conventions

Introduction
This guide uses the following conventions.

How commands are documented in procedures
As with many Windows applications, there are several different ways to exe
a command. For example, to copy text, you can choose any of the following
methods:

■ Choose Copy from the Edit menu.

■ Click the Copy button on the toolbar.

■ Type the keyboard shortcut Control + C.

The procedures in this guide document only the first method, choosing a 
command from a menu.

Navigation information in procedures: Getting there
Procedures in this guide are preceded by a Getting there statement. This 
statement summarizes the steps you take to navigate to the window or tab w
the procedure is carried out.

All Getting there statements start at the Nortel SMI window. This assumes 
have logged on and selected the appropriate system. Each item mentioned
that represents an icon, window, or tab that makes up the path to the final 
destination. 

Example
To define special mailboxes such as the broadcast mailbox, you must be o
Mailboxes tab. The Getting there statement for this procedure is as follows:

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Messaging Administration
Integrated AMIS Networking Implementation and Administration Guide 33



About CallPilot  Standard 1.0

s. 
After you double-click Messaging Administration, the property sheet display
You then click the Mailboxes tab.
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Finding your way around CallPilot

In this section
Connecting to CallPilot 36

Multi-administrator access 44

Error handling in property sheets 46

Using the online Help 49
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Connecting to CallPilot

Introduction
To perform administrative tasks, or to build or work with CallPilot application
you must first connect to the Meridian Application Server (the MAS server).
The MAT Navigator and the System Management Interface (SMI) work 
together to give you access to your system and sites.

Selecting a system—the MAT Navigator
The first step in logging in is to launch the MAT Navigator, which has its ow
password. The MAT Navigator connects your administration client to the M
server. It displays all your sites and systems and enables you to select one
work on.
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Selecting a program—the System Management Interface (SMI)
When you select a system from the MAT Navigator, you are prompted for a
second password. At this point, the SMI window for the selected system or 
displays. 
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The SMI gives you quick and easy access to your system or sites. The SMI
a navigation tree to display the system’s hierarchy. In the tree, icons repres
the folders and programs. Double-click a folder icon to view its contents. 
Folders can contain programs and other folders. Double-click a program ico
run the associated program. 

Selecting an object—list views
When you launch certain programs, the first thing you see is a list view. The
view displays all the objects of a certain type (such as mailbox classes) tha
currently defined in the system. The list view includes predefined objects as
as those defined by an administrator. From the list view window, you can sel
specific object to work on.
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Viewing and changing properties
Select an object and display its properties by 

■ double-clicking it or 

■ single-clicking it and selecting Properties from the File menu

■ right-clicking it and selecting Properties from the popup menu

Entering data and choosing options—property sheets
A property sheet is displayed when you view an object selected from a list v
Certain programs, such as Messaging Administration, display a property sh
immediately after launching. Property sheets have one or more tabs. Each 
has fields, referred to as boxes, in which you can type data or from which y
can select options. 
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Some property sheets are divided into two panes. When a box is checked i
left pane, the selected capabilities are enabled and you can access the ass
tabs. Select a tab by clicking its name in the left pane or by clicking the tab in
right pane. These property sheets look like this:
 

Mandatory boxes
If the name of a box is underlined, the box is mandatory, and you must fill it
You cannot save if any mandatory boxes are empty.
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Common buttons
The following buttons appear on most property sheets: 

Using the toolbar buttons
For easier access, some of the more common tasks, such as Print and Sav
represented as buttons on the toolbar. 

The following buttons are used throughout CallPilot. Buttons or icons specifi
certain CallPilot functions, such as backups and archives, are documented 
relevant chapters.

Button Description

Save Saves all changes made on any of the tabs in a property s
and closes the property sheet. Therefore, save only when y
have made the necessary changes on all tabs.

Cancel Closes the property sheet without saving any changes.

Print Prints the contents of all tabs in the property sheet.

Help Displays Help for the current tab. From this overview Help 
topic, you can access other Help topics, the index, and the
search function.

Toolbar button Description

. 

Saves any changes you have made and then transfers 
the application’s data to the server.

. 

Opens the Print dialog box and prints the active file or th
objects you specify.

. 

Deletes the object you select.
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Displays the properties of the object you select.

. 

Displays the Help topics window.

. 

Explains the next menu item or screen object you click. 
a window, there is an arrow. On tabs or in dialog boxes
there is no arrow.

. 

Opens the New dialog box, where you identify the 
properties of the object you are creating. The button loo
different in different applications.

. 

Displays the Open dialog box, where you select an obje
to open. The button is different in different applications.

. 

Reloads the current page and displays the changes you
have made.

. 

Enables you to select how the system displays icons.

Toolbar button Description
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Multi-administrator access

Introduction
You can create multiple administrator accounts to make administering CallP
easier and more efficient. Multiple accounts enable administration 
responsibilities to be distributed among a number of people. Therefore, cer
administrators can specialize in certain tasks, such as maintaining users, 
performing backups, analyzing reports, or creating multimedia services. 

Access classes
For security reasons, administrators should be given access only to those pa
the system that relate to their role. For example, an administrator who is 
responsible only for creating multimedia services should have access only 
Application Builder and the Service Directory Number Table. 

Each administrator account is assigned an access class. An access class i
of the parts of the system and the level of access allowed. The access leve
as follows:

■ create/delete (enables an administrator to delete objects such as users
services)

■ edit

■ view

■ none

For example, an administrator may be able to create or delete objects in 
Application Builder but only view User Templates.

Simultaneous access
Multiple administrators can log in to CallPilot at the same time without 
overwriting other work.

If you are the first to log in to a particular resource, such as a specific mailb
class or user profile, and another administrator tries to access the same res
a dialog box appears to inform you of the other administrator. At this point, 
can do one of the following:
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■ Keep editing.

■ Save your changes, and release the resource to the other administrato

■ Cancel your changes, and release the resource to the other administra

If you do not respond to this prompt within two minutes—because you are a
from the terminal, for example—the system releases the resource so that o
can access it. If this happens, all your unsaved changes are lost.

An administrator who accesses a resource that is currently being edited se
read-only view of the property sheet in which all boxes are dimmed. This 
indicates that the resource is currently locked. The administrator is not notif
when the resource is released, but must try to access the property sheet ag
see whether its status has changed. 

If a user tries to log on to a mailbox while an administrator is changing the 
profile, the user is unable to log on and receives a message that says the m
is in use.

Refreshing screens
Because multiple administrators can access the same database at the sam
a Refresh command is available from the View menu to ensure that the view
are seeing is the most up-to-date. 

For example, if you are viewing a list of users when another administrator 
deletes a user, the only way to see the change is to refresh the screen. You
should, therefore, refresh the screen regularly.
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Error handling in property sheets

Introduction
If you make certain types of errors while entering data, you are not able to s
your changes until you correct the errors. For example, if you leave a mand
box empty, you receive a message prompting you to fix it. 

Note: These errors do not show up in the Event Browser or Alarm Monitor 
because the errors relate only to data entry and are not operational problem

How error handling works
There are two types of error messages.

Type 1
If you get this type of error message, click OK, and then fix the problem 
described in the message before you try to save again.
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Type 2
If you get this type of error message, click OK to see a list of errors.

Double-click an error from the list. Your cursor is automatically placed in the
box where the error was made so that you can correct it. 
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For example, if you double-click the second error, the Remote notification ta
displayed, with the cursor in the Target number box. 
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Using the online Help

Introduction
While administering or maintaining CallPilot, you may have questions about
purpose of certain boxes and buttons, or need more information about 
completing certain tasks. 

Online Help provides brief answers to the questions “What’s this?” and “How
I...?”
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Context-sensitive Help
If you need to know the purpose of a particular box or button, use context-
sensitive Help.

To access context-sensitive Help

1 Click the  icon in a window or the  icon on a tab or in a dialog 
box.

2 Point to the box or button for which you want more information, and click.

Result: A pop-up description of the selected object is displayed.
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Procedures
If you need to know how to do something, you can access procedures to lea
through a task. 

High-level tasks
In some cases, high-level tasks take you through longer procedures. These
also provide you with navigation to the step-by-step procedures they includ
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For example, setting up Delivery to Telephone requires several procedures
high-level task summarizes these procedures. You click the gray buttons w
the task to open the step-by-step procedures. The high-level task remains o
your screen so that you can continue to use it to move through the procedu
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Overviews
Overview topics provide brief descriptions of tabs, features, and the tasks ca
out from the tabs. However, the online guides contain more detailed feature
descriptions.

To access overview topics

Click the Help button on a tab.

To find information in Help
You can look up procedures and overview topics in the following ways: 

1 From the Help menu, select Help Topics.

Note: You can also press F1 on the keyboard.

2 Go to one of the following tabs: 

■ To see the table of contents of all the Help topics, select the Contents 
tab.

■ To look up a subject alphabetically, select the Index tab.

■ To do a full-text search to find topics that contain the words you enter, 
select the Find tab.
Integrated AMIS Networking Implementation and Administration Guide 53



About CallPilot  Standard 1.0
54 CallPilot



log 
c h a p t e r  2

Getting started

Integrated AMIS Networking is one of the networking solutions offered by 
CallPilot. Integrated AMIS Networking uses the industry-standard AMIS ana
protocol to exchange messages with AMIS-compliant systems that are 
configured in the local network database.

This chapter introduces Integrated AMIS Networking and provides a basic 
overview of the Integrated AMIS Networking implementation process.

In this chapter 
About Integrated AMIS Networking 57

Implementing Integrated AMIS Networking 67

How Integrated AMIS Networking works 73

How Integrated AMIS Networking handles messages 85

Coordinating with the system administrator 93
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About Integrated AMIS Networking

In this section
Overview 58

CallPilot and Integrated AMIS Networking 63
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Overview

Introduction
Integrated AMIS Networking is one of the networking solutions offered by 
CallPilot. This chapter introduces Integrated AMIS Networking and provides
basic overview of its implementation process.

You must be familiar with the basic concepts of messaging networks, dialin
plans, and protocols. To review these concepts, consult the Networking Planning 
Guide.

Definition: Integrated AMIS Networking
Integrated AMIS Networking is a CallPilot networking solution that is used t
exchange messages between users at different sites in a private messagin
network.

The following diagram is a conceptual illustration of how Integrated AMIS 
Networking works.
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AMIS protocol
Integrated AMIS Networking uses the industry-standard analog Audio 
Messaging Interchange Specification (AMIS) protocol. Because it is standa
protocol, AMIS can exchange messages with all AMIS-compliant messagin
systems, regardless of vendor.

The AMIS protocol uses dual-tone multifrequency (DTMF) signaling. DTMF
signaling is a global standard. Therefore, you can use Integrated AMIS 
Networking outside of North America.

Note: There are both analog and digital versions of the AMIS protocol, but 
CallPilot uses only the analog version. Therefore, AMIS refers to AMIS-Ana
throughout this guide.

Comparison with AMIS Networking
AMIS Networking is another networking solution offered by CallPilot. This 
solution also uses the AMIS protocol.

AMIS Networking is designed primarily for the exchange of messages with s
that are not part of the private messaging network. When a site is not includ
the private messaging network, it is called an open site.

Integrated AMIS Networking, however, is used to exchange messages with
that are part of the private messaging network. When a site is included in th
private messaging network, it is called an integrated site.

Because Integrated AMIS Networking uses the AMIS protocol, it can also b
used to send messages to open sites.
Integrated AMIS Networking Implementation and Administration Guide 59



Getting started  Standard 1.0

g 
es 
Key terms
The following terms are used throughout this guide:

Note: The term “virtual node,” which was used in Meridian Mail 
documentation, is replaced by the term “integrated site.” 

Relationship with AMIS Networking
The capability to exchange messages with open sites is inherent within 
Integrated AMIS Networking. That is, if you have Integrated AMIS Networkin
implemented on your local site, local users can send messages to other sit
within the private messaging network, as well as to open sites.

Term Definition

Open ■ Not defined in the network database

■ Not part of the private messaging network, in 
most cases

Integrated ■ Defined in the network database

■ Part of the private messaging network

Network administrator ■ Individual responsible for implementing and 
maintaining a site in the private messaging 
network
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Complex network with Integrated AMIS Networking
You can implement Integrated AMIS Networking on a complex messaging 
network that combines several networking solutions. A messaging network
often both open and private, combining various protocols.

The following diagram illustrates a complex network that includes Network 
Message Service (NMS), Enterprise Networking, AMIS Networking, and 
Integrated AMIS Networking. 

Because Enterprise Networking is implemented in this messaging network,
every site has a unique site ID number.

While the sites have more than one networking solution implemented, only 
protocol is used between any two sites (for example, Site 4 and Site 2 must 
on which protocol to use).

In this example, Site 1 implements VPIM Networking to exchange message
with an open site. Since the VPIM protocol is not used by Site 1 to communi
with any other site within the private messaging network, Site 1 does not 
implement Integrated AMIS Networking.
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When to use this guide
Use the Integrated AMIS Networking Implementation and Administration Gui 
if you use the AMIS protocol to exchange messages with integrated sites. Y
can also use this guide if you use the AMIS protocol to exchange messages
open sites.

If you use the AMIS protocol to exchange messages with open sites only, us
AMIS Networking Implementation and Administration Guide.
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CallPilot and Integrated AMIS Networking

Introduction
Integrated AMIS Networking supports most of the features offered by CallP

Integrated AMIS Networking features
The following table lists the CallPilot features that are supported by Integra
AMIS Networking.

For detailed information about CallPilot features, consult the Basic 
Administration Guide.

CallPilot feature Supported Notes

Call Sender Yes Call Sender can be used for both call 
answering and composed messages from 
Integrated AMIS Networking users if

■ the mailbox numbering plan follows the 
dialing plan, or

■ a remote user is added for the network 
user

Names Across the Network No

Name Addressing Yes This feature is available if users at the 
remote site are defined as remote users at
the local site.

Name Dialing Yes This feature is available if users at the 
remote site are defined as remote users at
the local site.

Personal Distribution Lists Yes Integrated AMIS Networking addresses c
be included in a user’s PDL.
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Shared Distribution Lists Yes A remote user is required. A network 
address cannot be entered into the Shared
Distribution List unless the address 
corresponds to a remote user.

Multiple Recipients No

Reply To No

Reply All No A message has only one recipient.

User’s Actual Personal 
Verification

Yes The user’s actual personal verification is no
carried across sites.

Administrator-Recorded 
Personal Verification

No An administrator can record a personal 
verification for remote users who are 
defined at the local site.

Remote Site Spoken 
Names

Yes A spoken name can be recorded for each 
remote switch location during 
configuration.

Private Tag No AMIS does not support private message 
tags. For this reason, messages tagged as
private are returned to the sender with a 
non-delivery notification.

Acknowledgment Tag Yes Acknowledgment tags indicate that the 
message was delivered to the remote 
system, not that it was listened to.

Urgent Tag Yes Users can tag a message as urgent, and 
system treats it as urgent for prioritizing 
delivery. However, the recipient of an urgen
message does not know it was tagged as 
urgent.

CallPilot feature Supported Notes
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Economy Tag Yes Users can tag a message as economy, a
the system treats it as economy for 
prioritizing delivery. However, the recipient 
of an urgent message does not know it wa
tagged as economy.

Received Time Announced Yes The time when the message was depos
into the mailbox is announced to the 
recipient.

Sent Time Announced No

120-Minute  Messages No Message body length is limited to eight 
minutes. Messages longer than eight 
minutes are not sent, and a non-delivery 
notification is sent to the originator.

Sender’s Name (Text) Yes

Recipient’s Name (Text) Yes If the recipients are defined as remote us
their names are provided.

Message Subject (Text) No

Sender’s Department No

Timed Delivery Yes

CallPilot feature Supported Notes
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In this section
Overview 68

Implementation in a complex messaging network 72
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Overview

Introduction
Planning is critical to successfully implement Integrated AMIS Networking. 
Before you begin to implement Integrated AMIS Networking, you must 
understand the basic implementation process and know what information to
provide.

The process for planning the implementation of a CallPilot networking solut
is described in detail in the Networking Planning Guide. The following 
overview assumes that you are familiar with this description.

Before you begin
The following assumptions are made:

■ The switch is installed and configured.

■ Sufficient trunks that connect the switch to a public switch are available

■ CallPilot is installed and configured, except for networking.

■ If it is part of the local site, Network Message Service (NMS) is fully 
implemented.

■ If implementation is an upgrade from Meridian Mail, all legacy informatio
is available or is migrated.

■ Contact is made with the network administrators of the remote sites.

Fulfill all of these requirements before you continue with the implementation
Integrated AMIS Networking.
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Implementation steps
To implement Integrated AMIS Networking, you must complete the followin
steps:

■ Gather information for the network.

■ Configure the switch for Integrated AMIS Networking.

■ Configure CallPilot for Integrated AMIS Networking.

■ Configure CallPilot for AMIS Networking if this functionality is also 
required.

■ Add and configure the sites that use Integrated AMIS Networking to th
local network database.

■ Test and back up the network.

Gather information for the network
The first step in implementing Integrated AMIS Networking is to gather the 
information required during the configuration. You must gather information 
about

■ the switch configuration

■ the remote sites

You must also create a network representation.

Gather information from the switch
Much of the information you need to implement Integrated AMIS Networking
available in the switch database.

For example, before you begin to implement networking, the switch is set u
make telephone calls to all the remote sites. The dialing plan exists in the sw
database. You must reflect the dialing plan settings when you configure 
CallPilot for networking.

Ask the administrator who is responsible for the switch configuration to prov
this dialing plan information.
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Create the messaging network representation
You need information about the other sites in the messaging network to cre
messaging network representation.

You must create a detailed representation. This representation, which is yo
blueprint for implementation, shows the relationship between all sites.

Configure the switch
The switch must be set up and configured at your site before you begin to 
implement Integrated AMIS Networking. However, you must check the 
configuration and ensure that it is properly configured for Integrated AMIS 
Networking.

The only additional switch configuration necessary for Integrated AMIS 
Networking is the creation and setting of phantom DNs.

Configure CallPilot
The network database contains information about your messaging network
When you configure CallPilot, you add information to the network database
You must add the following information to configure CallPilot:

■ general information about the message delivery configuration

■ detailed information about the local site: information about how the ser
handles messages and how the switch handles messages

■ detailed information about each remote site that communicates with th
local site using Integrated AMIS Networking

Validate the configuration
When you implement Integrated AMIS Networking, you add configuration 
information about the messaging servers and switch locations to your netw
database.

Before you add this information, CallPilot validates the information to ensur
that there are no conflicts.
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Keep records
As you plan and implement Integrated AMIS Networking, it is important to ke
detailed records about your site.

These records

■ Provide a source of information for support personnel.

■ Share information about the site with other network administrators.

Test the network
When you complete the configuration of Integrated AMIS Networking, you 
perform a test suite. This test suite ensures that the configuration is correct
that Integrated AMIS Networking is working properly.

Back up the network
When you successfully complete the test suite, you perform a backup. The
backup ensures that no configuration information is lost in the event of syst
failure.

See also
If you need additional information about the general implementation proces
consult the Networking Planning Guide.

The Networking Planning Guide provides a more detailed discussion about th
preliminary requirements, how to create network diagrams, and how to main
a network history.
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Implementation in a complex messaging 
network

Introduction
Integrated AMIS Networking is usually part of a complex messaging networ
that combines several CallPilot networking solutions.

Order of implementation
If you are implementing any other CallPilot networking solutions on your sit
you will make the process easier to understand and manage by following th
correct order of implementation.

The implementation of each networking solution builds upon earlier 
implementations. Information is often configured only once, and all subsequ
networking solutions that are implemented use this configuration.

Recommended order
The recommended order for implementation is

■ Network Message Service (NMS)—if the local site is an NMS site

■ Integrated AMIS Networking

■ Enterprise Networking

■ VPIM Networking

AMIS Networking
If your local site exchanges messages with both integrated and open sites,
implement Integrated AMIS Networking only. Integrated AMIS Networking 
also contains the functionality of AMIS Networking.

Implement AMIS Networking by following the procedures in the AMIS 
Networking Implementation and Administration Guide only if your local site 
exchanges messages with open sites exclusively.
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About Integrated AMIS Networking messages

Introduction
You use Integrated AMIS Networking to exchange messages with sites in a
messaging network. When you implement Integrated AMIS Networking, yo
configure the system to handle these messages in a particular way.

An understanding of the basic components of a message makes the 
implementation process and configuration of CallPilot easier to understand

Integrated AMIS Networking message
Every Integrated AMIS Networking message contains two parts:

■ a message header

■ the recorded message

Message header
The message header transmits to the receiving site with  DTMF signals. Th
header contains the following information:

■ the sender’s address (which includes the system access number and t
mailbox number)

■ the recipient’s address (mailbox number)

■ the system access number

■ the type of message (regular, acknowledgment, or non-delivery notifica
[NDN])

■ the priority applied to the message (private, urgent, or acknowledgmen

Message body
The recorded message and spoken name are played over the voice port of
sending site and are recorded by the receiving site. The recorded message
contains the following information:

■ the voice portion of the message

■ any attachments
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Message priorities
The sender can assign a message priority to an Integrated AMIS Networkin
message. There are three priorities:

■ economy

■ standard

■ urgent

One message priority, usually standard, is the default. Users must assign an
message priority manually.

Configuration required for each message priority
The message priority tag that is assigned to a message determines how Ca
handles the message.

When you implement Integrated AMIS Networking, you configure the 
scheduling parameters that determine how messages with different messag
priority tags are handled.

In general, you send economy messages during lower long-distance toll ch
periods. You send urgent messages quickly, with the emphasis on speed ra
than cost.
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About Integrated AMIS Networking 
parameters

Introduction
You set Integrated AMIS Networking parameters during the implementation
process. These parameters work with internal CallPilot settings to control h
Integrated AMIS Networking works.

Before you begin the implementation process, you must understand these 
parameters and decide on their settings.

Parameters set during implementation
CallPilot uses scheduling parameters to determine when to send messages
remote sites. CallPilot uses the following scheduling parameters:

■ batch threshold

■ stale times

■ economy message priority delivery start and stop times 

Parameter default values
CallPilot provides default settings for all scheduling parameters. The defaul
values are based on typical requirements.

To ensure a quick implementation process, use these default values.

After your system is operational, monitor usage to determine if the default 
settings are serving the needs of your users. You can modify the schedulin
parameters whenever users’ needs change.

For all default values, see Defaults on page 136.
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Batch threshold
The batch threshold is the number of standard and urgent messages that a
in queue waiting for delivery to a single remote site. When you send messag
batches, you make more efficient use of system resources. However, to en
that messages awaiting delivery are not held too long in the queue, the hold
time overrides the batch threshold. A message is held in a batch until eithe
batch threshold is exceeded or the holding time for standard or urgent mes
is reached.

Batch thresholds apply only to standard and urgent messages.

Holding time
Holding time is the period of time that a message is held in queue before 
CallPilot attempts delivery. CallPilot holds a message in queue while it awa
the arrival of more messages for the same destination. This bulk sending m
more efficient use of the system.

However, to ensure that messages are always delivered in a timely fashion
do not wait too long for the arrival of additional messages, they are held for 
a set period of time. This is the holding time.

CallPilot computes the holding time internally, based on the stale time.

Standard message holding time
The holding time for standard messages is one-third of the stale time for 
standard messages.

Urgent message holding time
The holding time for urgent messages is one-tenth of the stale time for urge
messages.
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Stale time
Stale time determines how long an undeliverable message is held within th
system before being returned to the sender with a non-delivery notification 
(NDN).

You set stale times independently for economy, standard, and urgent mess
Typically, the stale time for a standard message is longer than the stale tim
an urgent message, because it may be critical for a user to know that an ur
message was not delivered.

The following examples are based upon an Integrated AMIS Networking sit
that uses the default values.

Example 1
Milo Feinstein sends a standard message. The message is held in the queu
awaiting the arrival of three more messages. However, when the message 
waited in queue for 40 minutes (the holding time for standard messages), th
message is sent.

Example 2
Ronnie Prakesh and Philippe Dumont are users at the same site. Ronnie s
three standard messages for users at the remote site in Newmarket. Her 
messages are held in the queue. Philippe sends a message to a user at the
remote site. The batch threshold is reached, and all four messages are sen

Example 3
Barney Gumbolski sends an urgent message. It is held in queue. No other 
messages for the same remote site arrive within six minutes (the holding tim
urgent messages). Barney’s urgent message is sent.
78 CallPilot



November 1998 Getting started 

ages. 
s, 

y 

ning 
gular 

t 

. The 
ge is 
rge 
Economy delivery start and stop times
Economy messages are handled differently from standard and urgent mess
Economy messages are collected and are sent only during designated time
rather than held in queues.

The delivery start and stop times determine when the system sends econom
messages to their destinations.

Economy messages usually have a start time that corresponds to the begin
of lower-rate telephone charges, and a stop time set to the resumption of re
rates.

Example
The following example is based on an Integrated AMIS Networking site tha
uses the current default values.

At 8:00 a.m., Marge Sampson sends an economy message to a remote site
message is held in queue until the economy delivery start time. The messa
held in queue for a total of 16 hours. The economy message stale time is la
enough to take this into account.
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About AMIS Networking parameters

Introduction
The functionality of AMIS Networking is inherent within Integrated AMIS 
Networking. When you implement Integrated AMIS Networking, you decide
the local site can use this functionality, which enables users to exchange 
messages with open sites.

If your local site uses the AMIS Networking functionality, you must also 
configure the Open AMIS parameters that determine how messages to open
are handled.

Why these parameters are important
The Open AMIS parameters are important because they determine how 
CallPilot sends AMIS messages to open sites.

Since Open AMIS messages can incur long-distance toll charges, it is espe
important that you consider how these parameters are set.

Open AMIS parameters
The parameters that apply to Open AMIS messages are

■ economy message stale time

■ Open AMIS compose prefix

■ economy delivery start and stop times

■ Open AMIS delivery times

Economy message stale time
The economy message stale time for Open AMIS messages functions in th
same way as the economy message stale time for Integrated AMIS messag
80 CallPilot
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Open AMIS compose prefix
The Open AMIS compose prefix is a number that alerts CallPilot that the re
the number to be entered is an AMIS address.

The AMIS compose prefix must not conflict with any other prefixes used in 
system, such as the name dialing prefix or the VPIM prefix.

Example
A local user logs in to CallPilot and enters 75 to compose a message. The 
enters the Open AMIS compose prefix (in this example, 13). The system is
alerted that this message is being addressed to an open site. The user ente
system access number and the mailbox number to complete the address.

Economy delivery start and stop times
The economy delivery start and stop times for Open AMIS messages are si
in concept to the times for integrated AMIS economy messages.

However, because Open AMIS messages may incur long-distance toll char
you must set these carefully.

Open AMIS economy messages often have a delivery start time that corresp
to the start of lower long-distance toll charges and a stop time that correspo
to the resumption of regular rates.

Possible conflicts
The various scheduling parameters may conflict with each other. Therefore
when you set the Open AMIS delivery times, ensure that messages cannot
become stale before they are delivered.
Integrated AMIS Networking Implementation and Administration Guide 81



Getting started  Standard 1.0

ages 
ectly, 
re, 
ed 
Open AMIS delivery times
The Open AMIS delivery times determine the hours when Open AMIS 
messages are delivered during business days and nonbusiness days.

In some countries, these settings have legal ramifications. Open AMIS mess
are directed to telephones automatically. If you address the message incorr
the unintended recipient may be disturbed at an inappropriate time. Therefo
computer-generated calls, such as Open AMIS messages, are legally allow
only during specific times of the business day.

If your country has these regulations in place, configure the Open AMIS 
delivery times to conform to the regulations.
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Understanding Integrated AMIS Networking 
settings

Introduction
Sites within the messaging network that use Integrated AMIS Networking to
communicate use system access numbers (SANs) and networking connect
DNs to initiate and establish sessions.

Relationship of a system access number to a connection DN
The following diagram shows the relationship of a system access number t
connection DN. 

A system access number becomes a connection DN in the network databa
record of a remote messaging server.

G100990.eps

Delhi

Integrated AMIS
Networking

Milwaukee
Network Database Records

Remote Messaging
Server

Connection DN=
1#613#6631234#

Ottawa

Local Messaging
Server
SAN=

1#414#5971234#

Milwaukee

Delhi

Ottawa
Network Database Records

Remote Messaging
Server

Connection DN=
1#414#5971234#

Milwaukee

Local Messaging
Server
SAN=

1#613#6631234#

Ottawa

Delhi
Integrated AMIS Networking Implementation and Administration Guide 83



Getting started  Standard 1.0

MIS 

 
ite 
r in 

etwork 

to the 

 
e sent 

the 
en 

cal 

mote 
s 

 in 
How connection DNs work
The system access number uniquely identifies a site that uses Integrated A
Networking.

When you send a message to an integrated site, the local site looks up the
connection DN for that remote site and initiates the network call. The local s
identifies itself to the remote site by including its own system access numbe
the message header.

The receiving site takes that system access number and searches its own n
database for a connection DN that matches the system access number.

If a match is found
The receiving site identifies the sending site if it finds a connection DN that 
matches the system access number it received. When the recipient listens 
message, the sending site is identified.

If a match is not found
If the receiving site does not find a connection DN that matches the system
access number it received, it treats the message as an Open AMIS messag
from a remote site that is not part of the private messaging network. When 
recipient listens to the message, the sending site is identified only as an op
site.

Coordinated information
You must coordinate the information you need to exchange messages. A lo
site must gather information from every remote site with which it intends to 
exchange messages. You must give your local system access number to re
network administrators. These administrators enter your local system acces
number as a connection DN when they configure your site as a remote site
their network databases.
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In this section
Overview 86

What the MTA does 88

What the ANA does 91

How a message is transferred 92
Integrated AMIS Networking Implementation and Administration Guide 85



Getting started  Standard 1.0

f 
. 

IS 
ts.

ery 
Overview

Introduction
The scheduling parameters that you configure during the implementation o
Integrated AMIS Networking work with internal CallPilot networking settings
These internal settings are controlled by the

■ Message Transfer Agent (MTA)

■ Analog Networking Agent (ANA)

This brief overview provides a general understanding of how Integrated AM
Networking handles messages to help you interpret Alarm and Event repor

MTA responsibilities
The MTA provides many of the basic maintenance functions required by 
CallPilot networking. The MTA is responsible for the following services:

■ Queue outgoing network messages.

■ Determine when to begin sending messages to a remote system.

■ Receive incoming messages for delivery to local users.

■ Collect networking traffic Operational Measurements (OM) reports.

To ensure the timely handling of messages, the MTA wakes up CallPilot ev
minute.

When it wakes up, the MTA does the following:

■ initiates calls to remote sites

■ checks for stale messages

■ checks if any sites are in error status
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MTA Monitor
The MTA Monitor continuously watches the performance of the MTA. The 
MTA Monitor provides detailed information and is useful for regular 
maintenance and troubleshooting. 

For complete information about the MTA Monitor and how it is used, consult
relevant section in the Support Tools Guide.

ANA responsibilities
The ANA send messages to and from remote systems.

There is one ANA for every active port used during an Integrated AMIS 
Networking session.

Main steps of message transfer
There are three main steps in the message transfer process:

■ The Message Transfer Agent determines if the message is ready for 
transfer.

■ The Analog Networking Agent completes a communication process, 
known as handshaking, with the receiving site.

■ The message, which consists of the message header and the message
is transferred.
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Introduction
The Message Transfer Agent (MTA) handles most aspects of message 
transmission for CallPilot.

How MTA and ANA handle messages
The following diagram is a graphical representation of how CallPilot handle
Integrated AMIS Networking messages.
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The diagram shows the activity of both the MTA and the ANA in message 
handling.
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As the diagram indicates, the MTA handles most of the processing. Every 
minute, a scheduler wakes the MTA. The MTA scans the message queue f
each destination, and checks the status of messages awaiting delivery. Thi
determines if there are valid messages, according to the system parameter
configuration. The MTA then determines if the valid messages are ready fo
delivery, according to the set system parameters.

Once the MTA determines that a transmission session is needed, it seeks a
method of delivery from the call router. The ANA assumes responsibility for
delivering the message.
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What the ANA does

Introduction
The Analog Networking Agent (ANA) works with the MTA to handle message

How the ANA sets up calls
The ANA calls a remote site and delivers messages. 

CallPilot originates a network call to the receiving site using the connection
directory number (DN) defined for that site. The switch places the call accord
to switch call-processing parameters.

If the call is successful, the call terminates on the networking connection DN
the receiving site.

If the call is not successful
If the call fails due to a busy or no-answer condition, CallPilot waits until the
next wake-up interval before it attempts the call again. If three consecutive 
attempts fail, CallPilot places the receiving site into error status and an alar
generated, depending on the nature of the problem.

CallPilot waits for one hour before it repeats the three-call attempt cycle.

When connection is established
When connection between the sending and receiving sites is established, A
initiates a communication process known as handshaking.
Integrated AMIS Networking Implementation and Administration Guide 91



Getting started  Standard 1.0

ssage 
How a message is transferred

Introduction
After the ANA successfully establishes a message transfer session, the me
transfer begins.

The message contains the message header and the recorded message.

Message transfer process
The following table describes how messages are transferred:

The sending site The receiving site

uses DTMF tones to send the message 
header to the integrated site. The message 
header contains:

■ the sender’s mailbox number without 
location prefixes

■ the sender’s system access number

■ the recipient’s mailbox without location 
prefixes

receives the DTMF tones, 
interprets the tones, and creates 
the message.

plays the voice portion of the message 
across a voice port.

records the message body and 
adds it to the message.

repeats these steps for each message the 
sending site must send.

Note: The maximum number of messages 
in a transfer session is five.

repeats these steps for each 
message.

terminates the message transfer session. hangs up.
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Coordinating with the system 
administrator

In this section
Overview 94

Assigning a Restriction/Permission List for AMIS Networking messages 98
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Overview

Introduction
If the local site uses the AMIS Networking functionality that is inherent withi
Integrated AMIS Networking, and if you allow local users to send messages
open sites, you must establish user access.

You must carefully control user access, because long-distance toll charges
be incurred when messages are sent to open sites.

Levels of control
There are two basic levels of control:

■ When you define message delivery parameters, you define general sy
wide controls over AMIS Networking messages.

■ However, when you define different classes of users with basic 
administration, you define the access level individual users have to AM
Networking.

Basic administration
Basic administration tasks include setting up the following:

■ users

■ mailboxes

■ mailbox classes

■ Restriction/Permission Lists (if messages are sent to open sites)

See also
For detailed information on each basic administration task, consult the Basic 
Administration Guide.
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Purpose of basic administration
With basic administration you can be more precise about how you want AM
Networking to be used.

This precision is important because AMIS Networking can send messages 
outside of the private messaging network, which may result in long-distance
charges. Therefore, controlling the access of users can result in considerabl
savings.

Example: Basic administration settings
You implement Integrated AMIS Networking and enable AMIS Networking 
well. You configure your site to send and receive AMIS Networking messag
However, you restrict this ability to specific groups of users only.

Mailbox class settings
You control a user’s access to AMIS Networking, in part, by the mailbox clas
which the user is assigned.

The following options for each mailbox class are available only if AMIS 
Networking is implemented:

■ default message priority—standard or economy

■ permission for exchange of messages with open sites

■ Restriction/Permission List for open messages, if you allow users to se
messages to open sites

You must set the AMIS Networking options for each mailbox class.
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Getting there  Nortel SMI > Meridian Application Server > User Administration > 
Mailbox Classes > Call Handling tab

To set the default message priority

To set the default message priority as standard, select Standard.

To set the default message priority as economy, select Economy.
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To control the exchange of open networked messages

1 To enable this mailbox class to send messages to open sites, select the 
Compose/send check box.

2 To enable this mailbox class to receive messages from open sites, select 
the Receive check box.

3 If you have enabled this mailbox class to send messages to open sites, set 
the Restriction/Permission List.

For instructions on how to set a Restriction/Permission List, see Assigning 
a Restriction/Permission List for AMIS Networking messages on page 98.
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Assigning a Restriction/Permission List for 
AMIS Networking messages

Introduction
If you allow local users to exchange messages with open sites, create any 
necessary Restriction/Permission Lists for AMIS Networking. A Restriction/
Permission List defines any restrictions to access and also lists any exceptio
these restrictions.

Example
Local users can send messages to open sites. However, you want to ensur
different classes of users can send messages only to specific sites. Users w
manager-level mailbox class can send messages to any site. Users with a 
summer student mailbox class can send messages to any open site that do
incur long-distance toll charges.

Purpose
A Restriction/Permission List provides additional security and prevents 
unauthorized long-distance toll charges.

Creating a Restriction/Permission List
Usually, you will assign a pre-existing Restriction/Permission List. However
no pre-existing list satisfies your requirements for AMIS protocol messages,
can create a new list.

See also
For detailed procedures on creating a Restriction/Permission List, consult t
Basic Administration Guide.
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Gathering information

This chapter describes how to gather the information required to implemen
Integrated AMIS Networking. This chapter provides a checklist for all 
information that is needed about the switch configuration.

This chapter also describes how to gather information about the other sites 
messaging network, and how to convert this information into a messaging 
network representation.

In this chapter 
Information required 101
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Information required

In this section
Overview 102

Switch information 103

Information required from switch 105

Evaluating the switch information 108

Information from other sites 109

Messaging network representation 110
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Overview

Introduction
Before you can begin to implement Integrated AMIS Networking, gather the
information you require. You will speed up the implementation process if yo
have this information before you begin. When you analyze the information a
look for inconsistencies and incompleteness, you ensure that potential prob
are resolved.

Required information
You must gather two types of information:

■ local site information, especially about the switch configuration 
information and dialing plan

■ messaging network information that is provided by all remote sites

Why gather information?
The gathered information is used to

■ Identify the sites in the messaging network.

■ Identify how the sites relate to each other.

■ Identify the dialing plan used by each switch in the network.

■ Determine if the dialing plan on one or more switches in the network m
be modified to support the networking solutions of CallPilot.

■ Create a messaging network representation.

■ Prepare for CallPilot configuration.

Information about open sites
If local users exchange messages with open sites, gather the system acces
numbers of these open sites.

You also need the system access number of at least one open site that you
use when you test your implementation. Coordinate with the administrator o
remote open site before you begin to test the implementation.
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Switch information

Introduction
When you begin to implement Integrated AMIS Networking, the switch is 
already correctly installed and configured, and is operational for CallPilot.

This means that the switch is set up for dialing among the sites in the mess
network. The dialing plans that are configured on the switch for making 
telephone calls between sites are also used to exchange messages among

You must check the configuration to make sure it is suitable for Integrated A
Networking.

Gathering dialing plan information
You need the dialing plan information that is configured on the switch. You m
know the dialing plan used in the messaging network and how all sites dial 
another.

The easiest way to gather this information is to ask the switch technician or
system administrator.

Gathering information directly from the switch
Gathering information directly from the switch is not recommended. The 
information that you require is found on several switch configuration files ca
overlays. Finding the information can be difficult and time-consuming. 

If you must gather the information from the switch, consult your switch 
documentation for the proper procedures and detailed descriptions of the 
information in each overlay.
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Confirming settings
Usually, when the switch is configured, the switch technician addresses the
impact of messaging on the switch.

However, to ensure that there will be no problems, you must confirm that th
configuration suits the needs of Integrated AMIS Networking and can hand
your anticipated volume of traffic.

If you discover that changes are necessary, you must complete these chan
before you proceed with the implementation of Integrated AMIS Networking
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Information required from switch

Introduction
You must gather information about the switch. You must verify that the swit
supports networking. You use some of the information, such as dialing plan
information, to configure CallPilot.

Gather information from

■ the local prime switch location

■ the remote switch locations (prime and satellite)

Note: If the local site is an NMS site, you must also gather information from
each satellite switch location. For instructions on how to gather this informat
consult the NMS Implementation and Administration Guide.

Gather information about used features only
Most of the information that you gather from the switch is related to the dial
plan.

Gather information about a dialing plan only if a dialing plan is being used. 
not gather the information if the dialing plan is installed on the switch but is 
currently being used.

Example: Your switch has both ESN and CDP installed. However, only ESN
used. Do not gather CDP information.
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Local prime switch location information checklist
You need the following information from the switch configuration:

■ name or physical location of switch (useful to name the switch location
CallPilot)

■ dialing plan used

● Electronic Switched Network (ESN)

● Coordinated Dialing Plan (CDP)

● hybrid dialing plan, combining ESN and CDP

● another dialing plan, such as public switched telephone network

■ if ESN or hybrid dialing plan is used:

● ESN access code

● ESN location codes

- local switch location

- remote switch locations

● overlap of location codes with extension numbers

■ if CDP or hybrid dialing plan is used:

● CDP steering codes

- local switch location

- remote switch location

● overlap of steering codes with extension numbers

■ confirmation that sufficient trunks are available for anticipated networki
traffic

■ confirmation that restrictions are suitable for networking (for example, 
trunk group access restrictions [TGAR])

■ range of extension numbers used at the local site (for example, 7000–7

■ information about existing CDNs and phantom DNs that are defined on
switch
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Remote switch location information checklist
For each remote site in the messaging network, you need the following 
information about each switch location (prime and satellite):

■ name or physical location of switch (useful to name the switch location
CallPilot)

■ dialing plan used

● Electronic Switched Network (ESN)

● Coordinated Dialing Plan (CDP)

● hybrid dialing plan, combining ESN and CDP

● another dialing plan, such as public switched telephone network

■ if ESN or hybrid dialing plan is used:

● ESN access code

● verify the ESN location codes

- local switch location

- remote switch locations

● overlap of location codes with extension numbers

■ if CDP or hybrid dialing plan is used:

● CDP steering codes

- local switch location

- remote switch location

● overlap of steering codes with extension numbers

■ range of extension numbers used at the local site (for example, 7000–7

■ confirmation that all extension numbers at this switch location can be 
dialed directly from the local switch

■ confirmation that all extension numbers at this switch location can be 
dialed in the same way
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Evaluating the switch information

Introduction
When you have the dialing plan information from all switches in the messag
network, review the information to ensure that you do not have to make any
changes to switch configurations.

Mandatory requirement
The dialing plans of all switches in the network must have a uniform, or 
standardized, dialing plan.

A uniform dialing plan means that users on all switches dial the same way t
reach the same recipient. 

There is only one exception to this rule: ESN access codes can be differen

You need a uniform dialing plan to dial users on other switches within the 
messaging network and at public sites.

A uniform dialing plan offers the following benefits:

■ The network is easier to configure and maintain.

■ Future growth of the network is allowed.

Configuring dialing plan information
You need extensive switch programming experience to configure dialing pla
information on a switch.

See also
You can find detailed information on dialing plan configuration in your switc
documentation.

ATTENTION! If you determine that changes to the dialing plan 
configuration are necessary, ask a switch technician to
confirm your conclusion and make the necessary 
changes.
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Information from other sites

Introduction
Implementation of a networking solution is a coordinated effort. Many decisi
must be made before implementation begins.

Gather the following information before you begin to implement Integrated 
AMIS Networking:

■ site names

■ Enterprise site IDs, if Enterprise Networking is implemented in the 
messaging network

■ fully qualified domain names (FQDNs) of servers

■ the protocol used between the local site and all remote sites

■ the dialing plan used between the local site and all remote sites

■ connection DNs for each site that uses the AMIS protocol to exchange
messages with the local site

If any remote sites are NMS sites, also gather the following information for e
satellite switch location:

● switch location name

● switch type

● location ID
Integrated AMIS Networking Implementation and Administration Guide 109
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Messaging network representation

Introduction
A messaging network representation provides a complete summary of your
messaging network. This representation contains information about each o
sites and indicates the relationship between each pair of sites.

If sufficiently detailed, a messaging network representation is the primary so
of information for implementing a messaging network.

The more detail you can supply, the easier you will find the implementation
process.

A diagram is the most suitable form of representing most messaging netwo
A spreadsheet is more appropriate for large messaging networks.

Definition: Messaging network diagram
A messaging network diagram is a graphical representation of your network
includes the following types of information:

■ all sites in the network 

■ the protocols implemented at each site

■ the protocol used between sites

■ location codes and names

■ dialing plan information

Definition: Messaging network spreadsheet
A spreadsheet is more appropriate for representing a large messaging netw
provides the same information as the diagram.
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Benefits
There are many benefits to creating a representation of your messaging net
A representation

■ offers a clear view of how your network is connected

■ gathers all the required information in one source

■ provides a useful means of planning future modifications

■ helps during the analysis of traffic issues

■ reveals areas for improvement

■ provides support personnel with a concise, clear view of your network

Coordinating efforts
Administrators of other sites must provide much of the information for your 
network representation. For example, you need to know the site name and 
information of every site.

Although each site administrator creates a representation, ideally one site 
administrator should create a final version to distribute to all sites. This ens
that the representation is comprehensive and that each site uses the same
information for implementation.

Protecting the representation
Your network representation contains sensitive information. Keep it properl
stored and protected as part of standard security procedures.

See also
For detailed instructions on how to create a network representation, as wel
for several examples, consult the relevant section in the Networking Planning 
Guide.
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Configuring the switch for Integrated 
AMIS Networking

This chapter describes how to configure the switch to implement Integrated
AMIS Networking. This chapter introduces the concepts that are necessary
understand the configuration process and provides detailed configuration 
procedures.

In this chapter
Configuring the switch 115
Integrated AMIS Networking Implementation and Administration Guide 113
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Configuring the switch

In this section
Overview 116

SDN Table and Integrated AMIS Networking 118

Adding and configuring SDNs 124

Phantom DNs and Integrated AMIS Networking 128
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Overview

Introduction
The switch provides the call handling for CallPilot.

When you implement Integrated AMIS Networking, the switch is already 
installed and configured, and is operational. It is ready for the implementatio
Integrated AMIS Networking.

There are two steps in the configuration process. On the server, you must s
inbound and outbound service directory numbers (SDNs) for Integrated AM
Networking. On the switch, you must set up phantom directory numbers (D

Before you begin
Review the information that you gathered. Confirm the settings to ensure th
they are correct.

Before you begin to implement Integrated AMIS Networking, complete and 
any required changes to the switch settings.

How the switch views an Integrated AMIS Networking call
The switch handles an Integrated AMIS Networking message from the local
to a remote site like any other outbound telephone call.

The switch is already configured to handle outbound telephone calls.

Integrated AMIS Networking requirements
Like all services, however, Integrated AMIS Networking needs a route that 
connects the messaging server and the switch.

Integrated AMIS Networking requires only one additional configuration on t
switch. A phantom DN is required.
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See also
For detailed information about the switch, consult your switch documentatio

For information about how CallPilot works with the switch and how the swit
must be configured, consult the relevant section in the Advanced Administration 
Guide.
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SDN Table and Integrated AMIS Networking

Definition: SDN
A service directory number (SDN) is a number that enables a user to acces
CallPilot service. Each SDN must be unique so that CallPilot can identify th
requested service and play the appropriate prompts.

SDN Table
The system automatically creates the Service Directory Number Table duri
the initial installation of CallPilot. The SDN Table lists all SDNs and provide
details about their settings.

CallPilot uses the SDN Table to map directory numbers (DNs) to services. 
SDN Table lists both inbound and outbound SDNs.

Inbound and outbound SDNs
CallPilot requires both inbound and outbound SDNs. 

You must manually add an inbound SDN. An outbound SDN is created 
automatically if Integrated AMIS Networking is installed. Both the inbound a
the outbound SDNs require additional configuration.

Inbound SDNs
For most services, an inbound SDN is a number that a user enters to acces
service. However, the Integrated AMIS Networking inbound SDN is not a 
directly dialable number. A remote system dials this SDN when it delivers a
Integrated AMIS Networking message.

Outbound SDNs
CallPilot uses an outbound SDN to make the requested service available. A
outbound SDN consists of the word OUTBOUND and a number.
118 CallPilot
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Example: SDN Table
The following illustration shows an SDN Table that lists both inbound and 
outbound Integrated AMIS Networking SDNs. 

If another service shares the inbound Integrated Networking SDN, that serv
appears in the SDN Table. 

When you review an SDN Table, the only way you know if an SDN is share
by the description. For this reason, the description of the SDN should ment
that it is shared with the inbound Integrated AMIS Networking SDN.

SDN numbers
An SDN must be unique, but it is not randomly selected. CallPilot uses SDN
map numbers to services. There are also important relationships between t
SDN and other numbers used by the system.

Relationship of SDN to other numbers
The CallPilot SDN setup echoes the DN settings on the switch.

An important relationship exists between the inbound SDN and the local sys
access number (SAN), and the phantom DN on the switch. For example,
Integrated AMIS Networking Implementation and Administration Guide 119
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■ The inbound Integrated AMIS Networking SDN = 7400.

■ The phantom DN for Integrated AMIS Networking = 7400.

■ The Integrated AMIS Networking local SAN =
1-416-597-7400.

The Integrated AMIS inbound SDN on CallPilot must correspond to the 
Integrated AMIS phantom DN on the switch. Before you create an SDN for
Integrated AMIS Networking, confirm the phantom DN on the switch.

To view the phantom DN setting, consult the gathered switch information.

Phantom DNs
There are two ways to create an Integrated AMIS Networking phantom DN
the switch:

■ Define a new phantom DN for Integrated AMIS Networking.

■ Share an existing phantom DN of specific services.

Media type
To process a call, Integrated AMIS Networking needs access to a channel.
channel provides a connection between the Meridian Evolution switch and 
Digital Signal Processor (DSP) cards on the CallPilot server.

CallPilot supports three channel types. Each type corresponds to different 
media:

■ voice

■ fax

■ speech recognition

Integrated AMIS Networking can use all three channel types. However, a v
channel is recommended. By default, CallPilot automatically assigns a voic
port to Integrated AMIS Networking.
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Minimum and maximum channels
You must determine the channel resources for both inbound and outbound
Integrated AMIS Networking SDNs.

Every service, including Integrated AMIS Networking, requires channel 
resources to process calls. Channel resources are the number of channels
Integrated AMIS Networking has available. Channel resources are set as 
minimum and maximum values. The minimum value is the number of chan
that is always reserved for the exclusive use of the service.

This setting is important because, if you incorrectly allocate channel resour
users may experience delays in reaching requested services.

Example: Channel allocation
Your system has 96 available channels. You decide to dedicate a minimum
channels and a maximum of 30 channels to Integrated AMIS Networking. If
system handles only 5 Integrated AMIS Networking calls each day, a more
appropriate allocation is a minimum of 1 channel and maximum of 3 chann

Examples: How to use inbound and outbound Integrated AMIS 
Networking SDNs

The following examples describe a network that consists of two sites, and s
how to use the inbound and outbound Integrated AMIS Networking SDNs t
provide services. 

In these examples, it is important to distinguish between messages sent by
and calls made by the CallPilot system itself.
Integrated AMIS Networking Implementation and Administration Guide 121
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Example 1: Shared SDN
This example illustrates how to use a shared inbound SDN.

Howard wants to send a message to Joy in Chicago. He enters 6060, whic
directed to the SDN for Integrated Voice/Fax. The request is directed to 
CallPilot, which routes it to the outbound Integrated AMIS Networking SDN
The system in Philadelphia calls the remote SAN of the system in Chicago,
64447080, and the two systems complete the required handshaking before
message is transferred. 

The Voice Menu SDN, which is shared with the inbound Integrated AMIS 
Networking SDN, receives the message. The Voice Menu SDN is set to act w
it receives an AMIS initiator tone. The message is directed to Joy’s mailbox

G100994.eps

SDN Service

6060 Integrate Voice/Fax
6070 Announcement
6080 Inbound AMIS

Outbound AMIS 10

SDN Service
7070 Integrated Voice/Fax
7075 Express Messaging
7079 Fax on Demand
7080 Voice menu
        (acts on AMIS initiator tone)

Outbound Enterprise 10

MAS
Server

MAS
Server6444xxxx

6338xxxx

SAN = 64447080

SAN = 63386080

Joy Howard
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Example 2: Unique SDN
This example illustrates how to use an inbound Integrated AMIS Networkin
SDN that is not shared.

Joy wants to send a message to Howard in Philadelphia. She enters 7070, 
is directed to the SDN for Integrated Voice/Fax. The request is directed to 
CallPilot, which routes it to the outbound Integrated AMIS Networking SDN
The system in Chicago calls the remote SAN of the system in Philadelphia,
63386080, and the two systems complete the required handshaking before
message is transferred. The inbound Integrated AMIS Networking SDN rece
the message and directs it to Howard’s mailbox.

See also
For detailed information on SDNs and SDN Tables, consult the relevant sec
in the Advanced Administration Guide.

G100992.eps

SDN Service

6060 Integrate Voice/Fax
6070 Announcement
6080 Inbound AMIS

Outbound AMIS 10

SDN Service
7070 Integrated Voice/Fax
7075 Express Messaging
7079 Fax on Demand
7080 Voice menu
        (acts on AMIS initiator tone)

Outbound AMIS 10

Joy Howard

MAS
Server

MAS
Server6444xxxx

6338xxxx

SAN = 64447080

SAN = 63386080
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Adding and configuring SDNs

Integrated AMIS Networking SDNs
Integrated AMIS Networking requires an outbound SDN and an inbound SD

Outbound SDN
An outbound SDN is created automatically when you install Integrated AMI
Networking. You can modify the default channel resource allocation.

Inbound SDN
An inbound SDN is not created automatically. There are two ways to set up
inbound SDN:

■ Create a new inbound SDN.

■ Share an inbound SDN with certain other services.

The choice depends on your administrative requirements.

Services that can share an inbound SDN with Integrated AMIS 
Networking

Integrated AMIS Networking can share the inbound SDN of the following 
services:

■ Announcement Service

■ Enterprise Networking

■ Fax Information Service

■ Voice Menu

Do this If the primary concern is

Create new SDNs. Operational Measurement reports must be 
precise for each service.

Share SDNs with other 
services.

A shortage of DNs exists or is likely to exist.
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■ Time of Day Controller

■ Thru-Dial

Getting there  Nortel SMI > Meridian Application Server > System Configuration 
> Service Administration > Service Directory Number

To add and configure a new inbound SDN

1 From the SDN Table, select New from the File menu.

Result: The New Inbound Service Directory Number Properties dialog box 
appears.

2 On the General tab, enter the SDN number in the Service DN box.

Note: This number must correspond to a CDN or phantom DN on the 
switch.

3 Select an application from the Application Name list.

Result: The corresponding application ID appears in the Application ID 
box.

4 Select the type of channel required by the service in the Media Type list.
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5 If you want to reserve a minimum number of channels for the service, enter 
the number in the Minimum Channels box.

6 Do one of the following:

■ Select the Use Default Maximum box. This is the recommended option.

■ Enter the maximum number of channels that a service can use at one 
time in the Maximum Channels box.

Note: The maximum number of channels cannot exceed the total number 
of channels available on the server. If you enter a number larger than the 
total number of channels, a warning box appears asking you to change the 
number.

7 Enter any comments in the Comments box.

8 Click Save to add the SDN to the SDN Table.

To share an existing inbound SDN with Integrated AMIS Networking

1 Select an existing inbound SDN that can be shared with Integrated AMIS 
Networking from the SDN Table.

2 On the File menu, click New.

Result: The New Inbound Service Directory Number Properties dialog box 
appears.

3 On the General tab, in the Comments box, insert a brief comment that the 
SDN is shared with Integrated AMIS Networking. 

Tip: This comment appears in the final column of the SDN Table and is the 
easiest way to determine which SDN is shared with Integrated AMIS 
Networking.
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4 Click the Session Profile tab.

5 Select the Act on AMIS/Enterprise networking initiator tone box. 

Note: You select this option only for the SDN that is being shared with the 
inbound Integrated AMIS SDN.

6 Click Save to add the shared SDN to the SDN Table.
Integrated AMIS Networking Implementation and Administration Guide 127
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Phantom DNs and Integrated AMIS 
Networking

Switch setting required for Integrated AMIS Networking
SDNs on the server have a direct correspondence to phantom directory num
(DNs) on the switch.

If you create a new SDN for Integrated AMIS Networking, you need a phan
DN for Integrated AMIS Networking. If you share an existing SDN for 
Integrated AMIS Networking with an existing service, Integrated AMIS 
Networking also shares the phantom DN of that service.

Integrated AMIS Networking uses DNs
To access a CallPilot service, a user enters a unique dialable number. The
dialable number is known as a directory number (DN). There are different ty
of DNs, including extension numbers and telephone numbers. 

The switch uses the DN to route the call to the requested service.

Example 
A user enters a DN, 7505, to access Remote Notification.

Switch and DNs
All DNs that you use to access a service correspond to a setting on the switc
handle calls in sequence of arrival, the system places calls in a queue, depe
on the call type.

The switch has as many as three queues, called controlled directory numbe
(CDN) queues, which you use for the following types of services:

■ Voice Messaging

■ Fax Call Answering

■ Speech Recognition Messaging

Each CDN queue is associated with a dialable number known as the CDN.
user can dial the service directly by entering the CDN.
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Example
The CDN of Voice Messaging is 7400. A user can dial 7400 to reach Voice
Messaging. The call is placed into the queue.

Phantom DNs
While there are queues for three types of services, CallPilot users usually h
many individual services available within each type. These services are als
dialable.

To offer more than three services, the switch uses phantom DNs.

A phantom DN is a unique dialable number that is routed to one of the CDN
queues.

A phantom DN is not a randomly selected number. There is a direct 
correspondence between the local system access number (SAN) for Integr
AMIS Networking and the phantom DN.

If Integrated AMIS Networking shares an existing phantom DN, check that 
phantom DN is configured to forward messages to the correct CDN queue.
Integrated AMIS Networking, the phantom DN should forward messages to
Voice Messaging CDN queue.

Example
The phantom DN for Express Messaging is 7401. A user dials 7401 and ex
to reach the requested service. However, the switch routes the phantom DN
the appropriate CDN queue (in this case, Voice Messaging) before the serv
provided.

Integrated AMIS Networking phantom DN
Integrated AMIS Networking requires a phantom DN for incoming message

However, unlike other phantom DNs, it is not dialed by a local user when 
exchanging a message with an Integrated AMIS Networking site. The syste
uses this number when an Integrated AMIS Networking message must be s
a remote site.

Users at remote sites also use the phantom DN when they make a call to a
system.
Integrated AMIS Networking Implementation and Administration Guide 129
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Ways to create the phantom DN
There are two ways to create a phantom DN for Integrated AMIS Networkin

■ Use a unique phantom DN. Most switch technicians create additional 
phantom DNs for use by services like Integrated AMIS Networking.

■ Share an existing phantom DN. If Integrated AMIS Networking shares 
service directory number (SDN) with another service, it also shares the
phantom DN of the service.

See also
For a detailed description of how the switch is configured for CallPilot, cons
the Advanced Administration Guide.
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Configuring CallPilot for Integrated 
AMIS Networking

This chapter describes how to configure CallPilot to implement Integrated 
AMIS Networking.

The chapter introduces the concepts that are necessary to understand the 
configuration process and provides detailed descriptions of configuration 
procedures.

In this chapter 
About configuring CallPilot 133
Integrated AMIS Networking Implementation and Administration Guide 131
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About configuring CallPilot

In this section
Overview 134

Configuration summary 135

Message delivery parameters—AMIS 1 tab 138

Message delivery parameters—AMIS 2 tab 143

Configuring the message delivery parameters 147

Enabling AMIS Networking functionality 149

Creating a loopback mailbox 152
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Overview

Configuring CallPilot
The implementation of Integrated AMIS Networking requires additional 
configuration of CallPilot. This configuration determines how Integrated AM
Networking exchanges messages with other sites in the messaging networ

To configure CallPilot for Integrated AMIS Networking, you must

■ Confirm CallPilot administration settings.

■ Define Integrated AMIS Networking information.

■ Create a loopback mailbox.

Before you begin
Complete the switch configuration before you configure CallPilot.

If your Integrated AMIS Networking site is an NMS network, NMS should b
configured and tested.

ATTENTION! You must perform each step in the configuration proce
in the order presented.
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Configuration summary

Introduction
The Integrated AMIS Networking message delivery configuration determine
how Integrated AMIS Networking handles messages.

You provide this information on two tabs of the Message Delivery Configurat
dialog box:

■ AMIS 1

■ AMIS 2

Required information
When you complete the AMIS 1 and AMIS 2 tabs, the following are require

■ enabled outgoing and incoming Integrated AMIS Networking

■ defined local AMIS system access number

■ batch threshold

■ economy delivery times

■ stale times

See also
For a general overview of how Integrated AMIS Networking uses this 
information, see the section How Integrated AMIS Networking works on page 
73.

Open AMIS boxes
As you configure the Integrated AMIS Networking message delivery 
information, you will see several boxes for configuring Open AMIS.

If users at the local site exchange messages with open sites, you must also
configure the Open AMIS boxes.
Integrated AMIS Networking Implementation and Administration Guide 135
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Defaults
CallPilot provides default settings for the message delivery configuration. T
default values are based on typical requirements.

To simplify the process of implementing Integrated AMIS Networking, use t
default values. After your system is operational, monitor usage and perform
to determine if the default settings are sufficient. You can modify the setting
whenever users’ needs change.

Parameter Current default

Batch threshold 4 messages

Stale time for standard messages 2 hours

Holding time for standard messages 40 minutes (calculated internally,
based on stale time settings)

Stale time for urgent messages 60 minutes

Holding time for urgent messages 6 minutes (calculated internally, 
based on stale time settings)

Stale time for economy messages 6 hours

Delivery start time for economy 
messages

6:00 p.m.

Delivery stop time for economy 
messages

11:00 p.m.
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Suggested process
You should read through this section on configuring Integrated AMIS 
Networking information. The settings that you select determine how efficien
your system handles Integrated AMIS Networking messages.

Ideally, know how you are going to complete the required information befor
you begin the configuration.

Before you begin
You must properly configure the inbound and outbound SDNs for Integrate
AMIS Networking before you configure Integrated AMIS Networking.
Integrated AMIS Networking Implementation and Administration Guide 137
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Message delivery parameters—AMIS 1 tab

Introduction
To implement Integrated AMIS Networking you must set the parameters tha
CallPilot uses to deliver messages.

These parameters are set on the Message Delivery Configuration AMIS 1 a
AMIS 2 tabs.
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AMIS 1 tab
The following shows the Message Delivery Configuration—AMIS 1 tab.
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Outgoing and incoming AMIS
If Integrated AMIS Networking is installed on your system, the following 
options are enabled by default:

■ Outgoing AMIS Networking

■ Incoming AMIS Networking

These boxes restrict the use of Integrated AMIS Networking. They also res
the use of AMIS Networking.

If you do not want local users to send outbound Integrated AMIS Networkin
messages, clear the Outgoing AMIS Networking option.

If you do not want local users to receive inbound Integrated AMIS Networki
messages, clear the Incoming AMIS Networking option.

To completely disable Integrated AMIS Networking, clear both options.

Local AMIS system access number
CallPilot requires a system access number (SAN) to initiate and establish 
network calls.

The system access number uniquely identifies an Integrated AMIS Network
site in a messaging network.

There are two types of system access number:

■ public network

■ private network

Public network local AMIS system access number
If your site has a public network system access number, your site can be re
from the public telephone switch network and the private messaging netwo

The use of a public network system access number allows more systems to
connect to your site.
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Private network local AMIS system access number
If your site has a private network system access number, your site can be re
only from the private messaging network.

Use a private network system access number if your messaging network is
connected to, or plans to connect to, systems over the public telephone swi
network.

The use of a private network system access number is uncommon.

Batch threshold
When you batch messages, you send messages that are intended for a sin
destination in a group. This method makes more efficient use of the system
if you send each message separately.

The batch threshold defines the maximum number of messages intended fo
single destination that can be queued before CallPilot begins to send the 
messages.

The batch threshold applies only to standard and urgent message types.

The batch threshold overrides the CallPilot holding times.

Stale times
Stale time is the period of time that CallPilot holds an undelivered message
before it considers the message undeliverable and returns it to the sender w
non-delivery notification (NDN). In the period before a message is consider
stale, CallPilot makes repeated attempts at delivery.

Stale time is expressed as a time period, such as 10 minutes or 5 hours.

Separate stale times are set for economy, standard, and urgent messages.
stale time for urgent messages should be the shortest time, because it is cr
to know if an urgent message is not delivered.

Set a stale time for economy Open AMIS messages if local users send AM
Networking messages to open sites.
Integrated AMIS Networking Implementation and Administration Guide 141
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Stale time settings affect holding times
CallPilot uses stale time settings to calculate holding times. 

The holding time is the period of time that a message is held in queue befo
attempt is made to send it.

Urgent messages
For urgent messages, the holding time is one-third of the stale time.

For example, if you set the urgent stale time to 30 minutes, the urgent mes
holding time is automatically set to 10 minutes. 

Standard messages
For standard messages, the holding time is one-tenth of the stale time.

For example, if you set the standard stale time to 5 hours, the standard me
holding time is automatically set to 30 minutes.

Holding times interact with the batch threshold
The interaction of the holding time and the batch threshold ensures that 
messages are delivered in a timely and efficient manner. A message is sent
the batch threshold is reached or when the holding time is reached, whiche
sooner.
142 CallPilot



November 1998 Configuring CallPilot for Integrated AMIS Networking 

 

 

Message delivery parameters—AMIS 2 tab

Introduction
You complete the configuration of the Integrated AMIS Networking delivery
parameters on the AMIS 2 tab.

Complete this tab for Integrated AMIS Networking. Complete all Open AMIS
fields to enable the functionality of AMIS Networking.
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AMIS 2 tab
The following shows the Message Delivery Configuration—AMIS 2 tab.
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Open AMIS compose prefix
If users are exchanging messages with open sites, provide the Open AMIS
compose prefix. This number alerts the system that the number about to be
entered is an Open AMIS address.

The Open AMIS compose prefix must not conflict with any other prefixes us
in the system, such as the name dialing prefix or the VPIM prefix.

Economy delivery start and stop times
An economy message is a message that a user tags for economy delivery.

Economy messages are treated differently from standard and urgent messa
Economy messages are collected through the day and sent only during 
designated times, rather than held in queues. The delivery start and stop tim
determine when the system sends economy messages to their destinations

Economy messages often have a start time set to the beginning of lower-ra
telephone services, and a stop time set to the resumption of regular rates.

Set two delivery times for economy messages:

■ start time

■ stop time

Example
If the telephone rate is lower between 11:00 p.m. and 6:00 a.m., set the star
at 11:00 p.m. and the stop time at 5:55 a.m.
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Open AMIS delivery times
If local users send AMIS Networking messages to sites that are not part of 
messaging network, you must define the Open AMIS delivery times.

Open AMIS delivery times determine how AMIS Networking messages are
handled during business and nonbusiness days. In some countries, these s
have legal ramifications.

Open AMIS Networking messages are considered computer-generated cal
Since they are sent to recipients who are not part of the private messaging 
network, there is a risk of disturbing the wrong recipient.

For this reason, many countries legally allow computer-generated calls only
during set times of the business day.

If your country has these regulations in place, configure the Open AMIS 
delivery times.

If your country does not have these regulations, or if your local site does no
send AMIS Networking messages to sites that are not part of the messagin
network, do not configure the Open AMIS delivery times.
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Configuring the message delivery parameters

Introduction
You must configure the parameters that determine how your system handle
messages.

You configure these parameters on the Message Delivery Configuration AM
and AMIS 2 tabs.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > AMIS 1 tab

To configure Integrated AMIS Networking parameters

1 To enable your site to send outgoing Integrated AMIS Networking 
messages, ensure that the Outgoing Integrated AMIS Networking check 
box is selected.

2 To enable your site to receive incoming Integrated AMIS Networking 
messages, ensure that the Incoming Integrated AMIS Networking check 
box is selected.

3 Select the type of network used by the local AMIS system access number.

4 If you use a public network system access number, enter the country code, 
the area/city code, and the system access number.

If you use a private system access number, enter the number used to dial 
the local site.

5 Enter the batch threshold in the Collect (number of) messages before 
sending (Batch Threshold) box.

6 Enter the stale times for each message type:

■ Standard

■ Urgent

■ Economy Integrated AMIS

7 To continue the configuration, click the AMIS 2 tab.
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8 Enter the Integrated AMIS economy delivery start and start times in the 
Start Time and Stop Time boxes.

9 To enable AMIS Networking functionality, complete the Open AMIS boxes 
on the AMIS 1 and AMIS 2 tabs, as described in Enabling AMIS Networking 
functionality on page 149.

For Integrated AMIS Networking functionality only, click Save.

Result: The information is validated and saved to the network database.
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Enabling AMIS Networking functionality

Introduction
If your local site sends messages to open sites you must configure all Open
AMIS boxes.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > AMIS 1 tab

To configure AMIS Networking

1 On the AMIS 1 tab, enter the Open AMIS stale time.

2 On the AMIS 2 tab, enter the Open AMIS compose prefix for AMIS 
Networking capabilities.

3 Enter the economy delivery start and stop times.
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4 Click the Define Open AMIS delivery times button for AMIS Networking 
capability.

Result: The Delivery Times dialog box appears. 

5 In the Business Days column, select the days of the week that are normal 
business days for your organization.

6 In the Non Business Days column, select the days of the week that are 
considered nonbusiness days for your organization.

7 Enter the Business Days delivery start and stop times in the Delivery Time 
from: and to: boxes.

8 Enter the nonbusiness days delivery start and stop times in the Delivery 
Time from: and to: boxes.
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9 Click Save.

Result: The Delivery Times dialog box closes and you return to the AMIS 2 
tab. The information is validated and saved in the network database.

What’s next?
After you configure CallPilot for Integrated AMIS Networking, create a 
loopback mailbox. 

Every site in the messaging network requires a loopback mailbox that remo
network administrators can use to test their systems. You will use the loopb
mailboxes created by remote network administrators to complete your testi

Although it is not mandatory, it is recommended that you create a loopback
mailbox at this time.
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Creating a loopback mailbox

Introduction
When you implement Integrated AMIS Networking, create a loopback mailb
Although it is not mandatory to create the loopback mailbox at this time, 
completing this task now will save you considerable time later.

Definition: Loopback mailbox
A loopback mailbox is a mailbox that is created at each site in a messaging
network. You use a loopback mailbox to test the capability of a site.

To test that a site can send a message to a remote site, a message is sent
loopback mailbox. The loopback mailbox automatically returns the messag
the sender.

Remote sites use your loopback mailbox to test their systems. You use the
loopback mailboxes of each remote site to test your system.

Since each site requires a loopback mailbox, create one now so that the te
can proceed without interruption.

Loopback mailbox requirements
A loopback mailbox is not a real mailbox because it does not collect messa
It bounces messages back to the sender. However, the loopback mailbox nu
must be unique and cannot conflict with any other mailbox number.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > Messaging 
Administration Properties > Mailboxes tab

To create a loopback mailbox

1 In the Networking Loopback mailbox box, enter the mailbox number.

2 Click Save.

Result: The information is validated and saved to the database.

Announce the loopback mailbox
Remote network administrators test their implementation by sending an 
Integrated AMIS Networking message to your loopback mailbox. Announce
loopback mailbox number to all remote sites.

Similarly, gather the loopback mailbox numbers from the network 
administrators of all other remote sites.

Using the loopback mailbox
A remote administrator addresses a test message to a loopback mailbox us
the protocol and dialing plans specified for use between the two sites.

For example, you create a loopback mailbox, 9999, on Site 6. Integrated AM
Networking is used between Site 4 and Site 6. The ESN dialing plan is used
the ESN prefix to address Site 6 from Site 4 is 3555. Therefore, to address
loopback mailbox, the network administrator at Site 4 enters 35559999.

See also
For more information on creating mailboxes and assigning them a class of 
service, consult the Advanced Administration Guide.
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Adding sites to Integrated AMIS 
Networking

This chapter describes how to define the sites in the messaging network th
exchange messages with the local site using Integrated AMIS Networking.

This chapter describes how to configure the local messaging server and pr
switch location. It also explains how to add and configure remote messagin
servers and switch locations.

In this chapter 
About the messaging network 157

Configuring the local site 163

Adding and configuring a remote site 185
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About the messaging network

In this section
Overview 158

Configuration and other networking solutions 159
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Overview

Introduction
A CallPilot messaging network consists of a local site and one or more rem
sites.

All sites in your private messaging network with which your local site exchan
messages must appear in the Messaging Network Configuration tree view.
remote site is part of the messaging network, but the local site does not exch
messages with that remote site using Integrated AMIS Networking, you do 
add it to the tree view during the implementation of VPIM Networking.

To implement Integrated AMIS Networking, configure the local site and add 
configure all remote sites that will transfer messages with the local site usin
Integrated AMIS Networking.

See also
Sites are configured in the Messaging Network Configuration tree view. For
overview of how to work with the tree view, consult the relevant section in t
Networking Planning Guide.

Before you begin
You should have already configured the Message Delivery Configuration dia
box for Integrated AMIS Networking.

If your local site is an NMS site, NMS should be configured and tested.

Your messaging network representation should be complete and available.
representation provides a blueprint for the implementation process.

ATTENTION! It is strongly recommended that you complete each ste
in the configuration process in the order presented.
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Configuration and other networking solutions

Introduction
If any other CallPilot networking solution is installed on your local system, 
much of the local messaging server and the local switch configuration work
already complete.

Configuring the local messaging server and switch location
If another networking solution is installed on the local site, the local messag
server and prime switch location configuration is almost entirely complete. Y
must only confirm the settings and enter the information that is specifically 
required to implement Integrated AMIS Networking.

NMS local site
If your local site is an NMS site, implement and test NMS before you begin 
implement Integrated AMIS Networking.

If NMS is installed, the NMS satellite switch locations for the local site appe
in the Messaging Network Configuration tree view below the local prime swi
location.

Remote sites
If another CallPilot networking solution is implemented on your system, rem
sites may already be added and configured. These sites appear in the Mess
Network Configuration tree view. These sites communicate with the local si
using the other networking solution.

When you implement Integrated AMIS Networking, you must add and config
the remote sites that will communicate with your local site using Integrated 
AMIS Networking. These sites appear in the tree view only as you add them
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Example: Implementing Integrated AMIS Networking
In this example, you are the network administrator of Site 6. Working with th
network administrators of the other sites, you have created a diagram of yo
messaging network. Note that many details are removed from this network 
diagram for clarity. 

Your local site has the following networking solutions: Integrated AMIS 
Networking, AMIS Networking (available because Integrated AMIS 
Networking is implemented), NMS, and Enterprise Networking.

Since you are following the recommended order of implementation, you ha
implemented and tested NMS.

To implement Integrated AMIS Networking, you add the following remote si
to your network database because you use the AMIS protocol to exchange
messages with them:

■ Site 3

■ Site 4

■ Site 5—satellite switches are also added

Your site is set up to exchange messages with an open site that is not part o
messaging network. When you set the Integrated AMIS Networking messa
delivery configuration parameters, you also complete all Open AMIS boxes

G101139.ep

 Site 1  Site 2

 Site 3  Site 4

 Site 5  Site 6

VPIM

AMIS

Satellite Satellite

Enterprise

VPIM

Integrated AMIS

Enterprise

VPIM

Integrated AMIS Enterprise

Integrated AMIS

Integrated AMIS

Integrated AMIS

Enterprise

Enterprise

Off-net
site

Satellite Satellite

PRIVATE MESSAGING NETWORK

Off-net
site
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After you implement and test Integrated AMIS Networking, you implement 
Enterprise Networking. During this implementation, you add Site 1 and Site 
the Messaging Network Configuration tree view because you use the Enter
Networking protocol to exchange messages with these sites.
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Configuring the local site

In this section
Overview 164

Configuring the local messaging server 166

Configuring the local prime switch location 171

Configuring ESN information 177

Configuring CDP information 181
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Overview

Introduction
When CallPilot is initially installed on your system, a local messaging serve
and local switch location are automatically added to the Messaging Networ
Configuration tree view.

Local messaging server name
By default, both the local messaging server and the prime switch location a
assigned the name “Untitled.” Assign new names to the local messaging se
and the prime switch location during configuration.

The local site receives its name from the name assigned to the local messa
server.

Configuration
You must configure the local messaging server. To configure a messaging se
you save general information about the messaging server, such as name a
description, to the network database.

The local messaging server is configured on the General tab of the Local S
Properties dialog box.

SMTP/VPIM Server FQDN
The SMTP/VPIM Networking Server FQDN box is enabled only if VPIM 
Networking is installed on your system. It is configured during the 
implementation of VPIM Networking.

However, if the box is enabled on the General tab, you must enter a placeh
in the box or you will be unable to close the tab and save the information to
network database.

While implementing Integrated AMIS Networking, enter a placeholder in thi
box. You will replace this placeholder with the correct server FQDN when y
implement VPIM Networking.
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Configuring the local server if another messaging solution is 
implemented

If you have implemented another CallPilot networking solution on your loca
system, you have already completed the local messaging server configurat

No additional configuration is required for Integrated AMIS Networking.
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Configuring the local messaging server

Introduction
You must configure the local messaging server to implement Integrated AM
Networking.

If another networking solution is implemented, the configuration of the local
messaging server is complete. You must only check the information.

The local messaging server is configured on the Local Server Properties—
General tab.
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Name
By default, both the local messaging server and the prime switch location a
assigned the name “Untitled.” Assign new names during configuration.

The messaging server is usually given a name that corresponds to its geog
location.

Local site name
The name given to the local messaging server becomes the name of the lo
site.

Server type
The local messaging server is always CallPilot.

Description
Provide a brief description of the messaging server, or implementation note
such as when the server was configured or who completed the configuratio
the Description box.

Send Messages to all other Servers
The Send Messages to all other Servers check box determines if the local s
can send messages to integrated remote sites in the messaging network.

This check box is selected by default and is cleared only under exceptional
circumstances.

When cleared, the local messaging server does not send messages to any
integrated remote site using any protocol. Messages can still be sent to ope
remote sites.

When to clear this option
This option lets you quickly disable messaging from your local site. Clear th
check box in emergency situations.
Integrated AMIS Networking Implementation and Administration Guide 167



Adding sites to Integrated AMIS Networking  Standard 1.0

to 

lar 
ote 

d 
ervers 

 you 

n still 

ing 

es 

aved 

r the 
Restricting messages to individual sites
Clearing the Send Messages to all other Servers check box is a quick way 
disable the system.

You restrict the sending of messages to each remote site separately.

To prohibit the local messaging server from sending messages to a particu
remote site, clear the Send Messages to this Server check box on the Rem
Messaging Server Properties—General tab.

For example, your messaging network has six sites. You do not want to sen
messages to one of these sites. You select the Send Messages to all other S
option while you configure the local messaging server. You clear the Send 
Messages to this Server box while you configure the remote server to which
do not want to send messages.

Note: When the Send Messages to all other Servers box is cleared, users ca
send messages to open sites using the VPIM and AMIS protocols.

Add/Update Remote Users on this Server
The Names Across the Network feature is available with Enterprise Network
only.

The Add/Update Remote Users on this Server check box enables the Nam
Across the Network feature to work with Enterprise Networking.

If enabled, this check box was configured during the implementation of 
Enterprise Networking.

Enterprise Site ID
The Enterprise Site ID box is enabled only if Enterprise Networking is 
implemented on your local messaging server.

If the Enterprise Site ID box is enabled, the Local Messaging Server 
Properties—General tab cannot be closed, and the information cannot be s
to the network database unless the Enterprise Site ID box contains some 
information. 

If you do not know the Enterprise site ID, enter a valid placeholder and ente
correct ID when you implement Enterprise Networking.
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Receive Message Text Info
The Receive Message Text Info check box is enabled only if Enterprise 
Networking is installed on your local messaging server. Configure this box w
you implement Enterprise Networking.

Server FQDN
The Server FQDN box is enabled only if VPIM Networking is installed on yo
local messaging server. The server FQDN is entered while you implement V
Networking.

However, the Local Server Properties—General tab cannot be closed and t
information cannot be entered into the network database unless the Server
FQDN box contains some information. 

If you know the server FQDN, enter it while you implement Integrated AMIS
Networking. Otherwise, enter a placeholder that you can replace while you 
implement VPIM Networking.

For example, enter “FQDN_goes_here.” A clearly marked placeholder remi
you to replace the information when you implement VPIM Networking.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration

To configure the local messaging server

1 In the Messaging Network Configuration tree view, select the local 
messaging server.

2 On the File menu, click Open.

Result: The Local Server Properties—General tab appears.

3 To change the name of the local messaging server, enter a new name in the 
Name box.

Tip: The name given to the local messaging server is also the name of the 
local site.

Note: The server type is always CallPilot and cannot be changed.

4 In the Description box, enter details about the local messaging server.
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5 To send messages to all other sites in the messaging network, ensure that 
the Send Messages to all other Servers box is selected.

Note: The Add/Update Remote Users on this Server check box is enabled 
if Enterprise Networking is installed. Configure this setting when you 
implement Enterprise Networking.

6 If Enterprise Networking is installed, enter the Enterprise Site ID number for 
the local messaging server or a valid placeholder.

Note: The Receive Message Text Info check box is enabled only if 
Enterprise Networking is installed. Configure this setting when you 
implement Enterprise Networking.

7 If VPIM Networking is installed, the Server FQDN box is enabled. Enter the 
FQDN or a valid placeholder.

8 Click Save.

Result: The information is validated and saved to the network database.

What’s next?
After you configure the local messaging server, you must configure the loca
prime switch location.
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Configuring the local prime switch location

Introduction
You must configure the local prime switch location to implement Integrated
AMIS Networking. 

The final step in configuring the local site for Integrated AMIS Networking is
configure the local prime switch location.

If any other networking solution is implemented
If another networking solution is implemented on the local site, the local pri
switch location configuration is already configured.

You must check the current configuration information. Make any necessary
modifications.

If NMS is implemented
If NMS is implemented on the local site, the information required for the loc
switch location configuration is already complete.

All satellite switch locations attached to the local prime switch location are a
already installed.

If no other networking solution is implemented
If no other networking solution is implemented on the local site, you must 
complete the General tab. You may have to complete the ESN tab or the C
tab, or both, depending on the dialing plan used on your local switch locatio
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Where the prime switch location is configured
The local prime switch location is configured on the Prime Switch Location 
Properties dialog box, which has four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM

General tab
Complete the General tab no matter what dialing plan your site uses.

ESN tab
Complete the ESN tab if the local site uses the ESN or a hybrid dialing plan
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CDP tab
Complete the CDP tab if the local site uses the CDP or a hybrid dialing plan

SMTP/VPIM tab
The SMTP/VPIM tab is enabled only if VPIM Networking is installed on you
local switch location.

You complete the SMTP/VPIM tab during the implementation of VPIM 
Networking.

General tab
The following explain all boxes on the General tab.

Name
Every switch location needs a name that is unique within the messaging 
network. Usually, this name is the same as the name of the messaging ser
This ensures that the identity of the switch location within the network is 
immediately apparent. A geographic name is common.

For example, if a messaging server is named “Moscow,” the prime switch 
location is usually also named “Moscow.”

By default, the local prime switch location is given the name “Untitled.” This
name must be changed.

Description
The Description box is useful for short notes, reminders, or comments abou
switch location.

You might find it useful to specify your switch model, the date of the switch 
configuration, or contact information for the switch technician.

Enterprise Location ID
The Enterprise Location ID box is not enabled for the prime switch location

Note: The location ID for the prime switch location is always 0 and cannot b
changed.
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Spoken Name Recorded
If your local site is not an NMS site, the Spoken Name Recorded check box
not enabled.

If your site is an NMS site, the Spoken Name Recorded check box was 
configured during the NMS implementation.

Dialing plan information
You need detailed information about the dialing plan used by the local site w
you configure the local prime switch location.

Dialing plans for dialing to this location
You must specify which of the following dialing plans is used to dial to the lo
switch location:

■ ESN

■ CDP

■ hybrid that combines ESN and CDP

■ another dialing plan (such as PSTN)

When you configure the local prime switch location, you specify the dialing p
that is used to dial to the local site.

Note: If you use ESN anywhere in the messaging network, you must select 
because you need an ESN access code.

Mailbox specifications
The following boxes are dynamically enabled and disabled depending on th
dialing plan you have specified for the local prime switch location:

■ Mailbox addressing follows dialing plan

■ Mailbox prefixes

Mailbox addressing follows dialing plan
The Mailbox addressing follows dialing plan check box is available only if NM
is installed on the local messaging server. If NMS is implemented, this chec
box should be properly configured already.
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Mailbox prefixes
A mailbox prefix is a leading string of digits that uniquely identifies a mailbo
number as belonging to a particular site.

If the local site does not have NMS installed, the mailbox prefixes are neve
required for the local prime switch location.

If the local site does have NMS installed, the mailbox prefix, or prefixes, are
already properly configured.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration

To configure the local prime switch location

1 In the Messaging Network Configuration tree view, select the local prime 
switch location.

2 On the File menu, click Open.

Result: The Messaging Network Configuration—Prime Location 
Properties—General tab appears.

. 

3 To change the name of the local prime switch location, enter a name in the 
Name box.

4 In the Description box, enter details about the local prime switch location.

Note: The Enterprise Location ID is always 0 and cannot be changed.

5 Confirm the status of the Spoken Name Recorded box.

Note: This box is enabled only if NMS is installed and was completed 
during the implementation of NMS.

6 Specify the dialing plan used to dial the local prime switch location. Select 
the

■ ESN check box if ESN is used

■ CDP check box if CDP is used

■ ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if another dialing plan, such as PSTN, 
is used.
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7 The Mailbox addressing follows dialing plan box and the Mailbox prefixes 
boxes are enabled only if NMS is implemented locally. If enabled, they are 
already configured.

8 Determine whether you must complete another tab. If not, click Save to 
close the dialog box. 

9 Select another tab to continue the configuration.

What’s next?

If the local site uses an ESN, CDP, or hybrid dialing plan
After you complete the General tab, you must complete the ESN tab, or the 
tab, or both tabs, depending on the dialing plan used.

If the local site uses another dialing plan
If your local site uses another dialing plan, such as PSTN, you have comple
the configuration of your local prime switch location.
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Configuring ESN information

Introduction
If the local prime switch location uses either an ESN dialing plan or a hybrid
dialing plan, you must complete the ESN tab.

You must provide the ESN access codes and ESN location codes. These a
combined to create the ESN prefix.

See also
For a description of the ESN dialing plan and how it works, consult the 
Networking Planning Guide.

. 
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ESN Access Code used by this location
The ESN access code is used to access ESN routing in the same way that
access code, such as 9, is used to dial out to the public network from a priv
network.

Typically, all switches in a messaging network use the same ESN access c

ESN Location Codes
An ESN location code is a routing prefix that identifies a location within a 
network. It is usually three digits long, but can be up to ten digits long.

You must also indicate the number of digits in the ESN location code that 
overlap the mailbox number.

The ESN Location Codes list contains all ESN location codes currently assig
and indicates the overlap between the ESN location code and the mailbox 
directory numbers.

ESN location codes can be added, modified, or deleted at any time. The ES
location codes must always match the dialing plan configuration on the swi

ESN location code capacity
The maximum number of ESN location codes for a switch location is 30.
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ESN location code overlap
When you are entering the dialing plan information for the local site, you mu
calculate the number of digits in the ESN prefix that overlap the digits in the
local extension.

If there is overlap between the rightmost digit or digits of the location code a
the leftmost digit or digits of the extension number, enter the amount of ove

The following table provides examples of ESN location code overlap.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Local Prime 
Switch Location Properties > ESN tab

Access 
code

Location 
code

Extension 
number

Number dialed by users at 
other sites Overlap

6 338 8300 63388300 0

6 338 8300 6338300 1

6 300 8000-8999 63008300-63008999 0

6 302 25000-26999 63025000-63026999 1
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To configure the ESN information

1 Enter the ESN access code.

2 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

3 In the Location Code box, enter the location code.

4 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the location code.

5 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes list on the ESN tab.

6 Repeat steps 3–5 for each ESN location code required.

7 When you have finished configuring the ESN information, determine if you 
must configure CDP information. 

● If yes, click the CDP tab. 

● If no, click Save to validate the ESN information and save it to the 
database.

What’s next?
If your local prime switch location uses the hybrid dialing plan, click the CD
tab to continue configuring the local prime switch location.
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Configuring CDP information

Introduction
If the local switch location uses either a CDP dialing plan or a hybrid dialing
plan, complete the CDP tab.

You must provide the CDP steering codes.

See also
For a general description of the CDP dialing plan and how it works, consult
Networking Planning Guide.
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CDP Steering Codes
A CDP steering code is a site prefix that identifies the local site within the 
network. Therefore, a CDP prefix must be unique for all switches in the 
messaging network.

CDP steering codes are determined by the switch technician. 

The CDP steering codes defined on the switch are entered on CallPilot bec
the system must be able to identify the steering code in the mailbox numbe
determine the site.

The CDP Steering Codes list box contains all CDP steering codes currently
assigned to the switch location. The list box also indicates the overlap betw
the CDP steering codes and the mailbox directory numbers.

CDP steering codes can be added, modified, or deleted.

CDP steering code capacity
The maximum number of CDP steering codes for a switch location is 500.

CDP steering code overlap
When entering the dialing plan information, you must calculate the number 
digits in the CDP steering code that overlap the digits of the local extension

If there is overlap between the last digit or digits of the steering code and the
digit or digits of the extension number, enter the amount of overlap.

Normally, the steering code overlaps with the first few digits of a local extens
number.

The following table provides three examples of CDP steering code overlap.

Steering 
code

Extension 
number

Number dialed by users at other 
sites

Amount of 
overlap

22 22345 2222345 0

22 22345 222345 1

22 22345 22345 2
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Local Prime 
Switch Location Properties > CDP tab

. 

To configure the CDP information

1 Click the Add New button.

Result: The New CDP Steering Code Properties dialog box appears.

2 In the Steering Code box, enter the steering code.

3 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the steering code.

4 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Code list box on the CDP tab.

5 Repeat steps 1–4 for each CDP steering code required.

6 When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and saved to the network database.

What’s next?
You have completed the configuration of the local site and are ready to beg
adding and configuring remote sites.
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Adding and configuring a remote site

In this section
Overview 186

Configuring a remote messaging server 187

Configuring a remote prime switch location 196

Configuring a remote satellite switch location 207

Recording a spoken name 211

Importing a spoken name 213

Non-CallPilot remote sites 215

Meridian Mail remote sites 217

Norstar Voice Mail remote sites 218
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Overview

Introduction
When you implement Integrated AMIS Networking, you add to the Messagi
Network Configuration tree view all the remote sites that use Integrated AM
Networking to exchange messages with the local site.

Every remote site added to the tree view must be configured.

Information required
The information that you enter when configuring a remote site reflects the 
information that is configured for that site in its own local network database.
example, you enter the name of that site and its FQDN. You must get this 
information from the remote network administrator.

But configuring a remote site is not simply copying the information provided
the remote site. You also enter information that reflects how your local site 
communicate with that remote site. For example, for each remote site you de
whether your local site sends messages to this particular remote server.

Main steps
There are three main steps to adding a remote site to your local network 
database. For each remote site, you must add and configure

■ the remote messaging server

■ the remote prime switch location

■ the remote satellite switch locations, if the remote site is an NMS site

Network representation
Much of the information that you must provide while configuring a remote 
messaging server is contained in the network diagram or spreadsheet.
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Configuring a remote messaging server

Introduction
When CallPilot is initially installed on your system, your local site, consisting
a local messaging server and a local prime switch location, is automatically
added into the Messaging Network Configuration tree view.

However, you must manually add each remote site that exchanges message
the local site using Integrated AMIS Networking into the Messaging Networ
Configuration tree view. Both the remote messaging server and the remote p
switch location must be configured.

The following tabs must be completed for each remote messaging server:

■ Remote Messaging Server Properties—General tab

■ Remote Messaging Server Properties—Connection Information tab

Remote servers and other networking solutions
If you have implemented another CallPilot networking solution on your syste
you have already added remote sites to the Messaging Network Configurat
tree view.

The process of adding a remote site is essentially the same regardless of th
networking solution being implemented. However, when you add remote si
during the implementation of Integrated AMIS Networking there are importa
differences to consider.
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Remote Messaging Server Properties—General tab
The Remote Messaging Server Properties—General tab contains detailed 
information about the remote messaging server and defines how the local s
and the remote site exchange messages.

. 

Name
You should assign the remote messaging server the same name that was as
to it by its local network administrator. This correspondence in naming sites
makes the network easier to administer and maintain because all network 
administrators use the same names for the same sites.

For example, if a remote site calls itself Connecticut, you should name it 
Connecticut when you add it to the Messaging Network Configuration tree v
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Server type
The remote messaging server can be any of the following types:

■ CallPilot (CallPilot)

■ Meridian Mail Net Gateway (MMNG)

■ Norstar Voice Mail (Norstar)

■ Meridian Mail

■ Other

Description
Provide a brief description of the remote messaging server or useful notes,
as when the messaging server was configured or who completed the 
configuration.

Send Messages to this Server
The Send Messages to this Server check box interacts with the Send Messa
all other Servers check box on the Local Messaging Server Properties—Ge
tab.

When you configured the local messaging server, you decided if you wante
local messaging server to send messages to all remote messaging servers
option is selected by default and is cleared under exceptional circumstance
only. 

However, you can still stop the delivery of messages to specific remote 
messaging servers. The Send Messages to this Server check box enables 
block the delivery of messages from your local messaging server to a partic
remote site.
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Example: In the following diagram, Helsinki is configured to deliver messag
to all other sites. However, the network database records for Paris and Cai
specify that messages are not sent to these remote sites. Messages are se
Lammi and Korso-Rekola. Therefore, while the potential exists for sending 
messages to both remote sites, only two sites in the messaging network re
messages from Helsinki.

Send local user information to this Server
The Send local user information to this Server check box determines if the 
Names Across the Network feature is used with this remote site. If enabled
feature was configured during the implementation of Enterprise Networking

G100995.eps
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Local Messaging
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Enterprise Site ID
The Enterprise Site ID box is enabled only if Enterprise Networking is insta
on the local site. 

All remote sites connected to a site that has Enterprise Networking installed
must have an Enterprise site ID, regardless of the actual protocol used with
site.

Therefore, if Enterprise Networking is installed locally, when implementing 
Integrated AMIS Networking, you must enter the site ID for all remote sites,
even those that exchange messages with the local site using the AMIS pro

Consult the network representation for the correct Enterprise site IDs.

Send Message Text Info to this Server
This check box applies only to remote sites that use Enterprise Networking
exchange messages with the local site. For remote sites that use Integrated
AMIS Networking, this box is not applicable.

Server FQDN
If VPIM Networking is installed on your local site, the VPIM Networking 
Server FQDN box is enabled.

However, since your local site transfers messages with this remote site usin
Integrated AMIS Networking, a Fully Qualified Domain Name (FQDN) of the
remote server is not required.
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Remote Messaging Server—Connections tab
The configuration of a remote messaging server continues on the Connecti
tab.

Network protocol
When implementing Integrated AMIS Networking, you must specify that the
protocol used by the local site to exchange messages with this remote site 
AMIS.

To use a particular protocol, both sites must have the same networking solu
installed and implemented.

If a remote site is not configured to use the same protocol as the local site, 
following occurs when the local site attempts to send a message:

■ The message is not delivered.

■ An error message is generated.

■ The remote site is put into error status on the local system.
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Integrated AMIS Networking connection DNs
When CallPilot initiates a call to a remote site, it uses the networking connec
DN that is specified for the remote site in your network database.

You can define up to three DNs. DN1 is mandatory. DN2 and DN3 are optio

At least one connection DN must be the Integrated AMIS Networking syste
access number for the remote site, as defined on the AMIS 1 tab of the Mes
Delivery Configuration Properties dialog box of the remote site.

You should include the system access number of the remote site on the ne
representation. If you do not have the system access number, contact the 
administrator of the remote site.

The connection DNs are entered in a format that is dialable from the local s
Connection DN1 should be the least expensive means of calling the remote
For example, if you use the ESN dialing plan between the sites, use the ES
prefix for connection DN1 and the PSTN number for connection DN2.

The system always uses DN1 to reply to a message from the remote site, u
it encounters problems. If the system does encounter a problem, it attempts
contact the remote site using another DN.

See also
For a general discussion of how connection DNs are used, consult 
Understanding Integrated AMIS Networking settings on page 83.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To configure a remote messaging server

1 In the Messaging Network Configuration tree view, select Remote Server 
Maintenance.

2 On the File menu, click New > Messaging Server.

Result: The Remote Messaging Server Properties dialog box appears.

3 On the General tab, in the Name box, enter the name of the remote 
messaging server.

4 Select the server type from the Server type box.
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5 In the Description box, enter details about the remote messaging server.

6 To enable the local messaging server to send messages to this remote 
messaging server, ensure that the Send Messages to this Server box is 
selected.

7 If an Enterprise site ID is required, enter the unique site ID number of the 
remote messaging server or a valid placeholder.

8 To continue configuring the remote messaging server, click the 
Connections tab.

9 From the Network protocol list, select AMIS.

Result: The Define buttons become enabled.

10 Click the Define button for DN1.

Result: The New DN dialog box appears. 

11 Enter the required DN.

■ For a public network, enter a public DN.

■ For a private network, enter a private DN.

12 Click Save.

Result: The DN appears in the Connection DNs box on the Connections 
tab.

13 Repeat steps 9–12 for each connection DN.

Note: DN1 is mandatory. At least one DN must be the system access 
number of the remote site.
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If you are defining more than one connection DN, list them in order of cost. 
Connection DN1 should be the least expensive means of contacting the 
remote site.

14 Click Save.

Result: The information is validated and entered into the network 
database.

What’s next?
After you add information about the remote messaging server into your loca
network database, you must also add information about the remote prime s
location.
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Configuring a remote prime switch location

Introduction
When you added a remote messaging server to the Message Network 
Configuration tree view, a corresponding prime switch location was added.

A remote prime switch location must be configured. This process is almost 
identical to configuring the local prime switch location.

Remote Prime Switch Location Properties dialog box
The remote prime switch location is configured on the Remote Prime Switc
Location Properties dialog box, which has four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM

General tab
Completing the General tab is mandatory.

ESN tab
Complete the ESN tab if an ESN or hybrid dialing plan is used with this rem
site.

CDP tab
Complete the CDP tab if a CDP or hybrid dialing plan is used with this remo
site.

SMTP/VPIM tab
Because your local site is not using VPIM Networking to transfer messages 
this remote site, do not complete the SMTP/VPIM tab.
196 CallPilot



November 1998 Adding sites to Integrated AMIS Networking 

d to 
e is 

rver 
me 

.

Remote Prime Switch Location Properties—General tab

Name
Assign a unique name to each switch location. The name should correspon
the switch location to make the location easy to identify. A street or city nam
a good choice.

The remote switch location is automatically given the name of the remote se
that was added to the Messaging Network Configuration tree view. This na
can be changed.

Description
Enter short notes or comments about the remote switch location in this box
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Enterprise Location ID
The Enterprise Location ID box is enabled only if Enterprise Networking is 
implemented on the local site.

A location ID is required for all remote sites if Enterprise Networking is 
installed locally, even if another protocol is used to exchange messages wit
site.

The location ID of the prime switch location is set to 0 by default and canno
changed.

Spoken Name Recorded
When local users compose a message to this remote site or use the playba
feature to determine the sender of a message, they hear a message that id
the sender. The content of the message depends on whether a spoken nam
that remote site is recorded.

If a spoken name is recorded, voice mail users hear the location name follo
by the local mailbox directory number.

Example: “Dallas, Mailbox 2346”

Spoken name not recorded
If a spoken name is not recorded, local users hear a full mailbox address th
does not identify the sender’s site by name.

For example, for an ESN switch location, users hear the ESN location prefi
followed by the local mailbox directory number.

Example: “Mailbox 6444 2346”

When a spoken name is not desirable
You may decide that you do not want local users to hear a spoken name fo
particular remote site. For example, if CDP is used for messaging with this 
remote site and the mailbox numbers follow the dialing plan, you may decid
that a recorded spoken name is unnecessary. In this case, do not record or 
a spoken name.

Ways to add a spoken name recording
There are two ways to add a spoken name recording: record a spoken nam
directly by clicking the Record button, or import a prerecorded message.
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Dialing plan information
Provide general information on the dialing plan used by the switch.

The dialing plan boxes have complex interactions. They are dynamically 
enabled or disabled depending on the choices made. Complete all enabled
boxes.

Dialing plans for dialing to this location 
You must specify which dialing plan is used to dial this remote switch locati
from the local switch location. There are four possible dialing plans:

■ ESN

■ CDP

■ hybrid combining ESN and CDP

■ another (such as PSTN)

Mailbox addressing follows dialing plan
When a mailbox follows the dialing plan, a user dials and addresses a messa
a recipient in the same way. There are two ways to achieve this correspond

■ A user’s mailbox number and extension number are the same.

■ The addressing plan and the dialing plan are the same.

If either situation is true, select the Mailbox addressing follows dialing plan 
check box.

Clear this option if users at the site do not dial and address recipients in the 
way.

Example: If the local ESN prefix is 6222 and the local mailbox is 1234, remo
users can dial the local user with the number 62221234, which is the ESN p
and the mailbox number combined.

Example: If the CDP steering code is 22 and the local mailbox is 1234, rem
users can dial the local user with the number 221234, which is the steering 
and the mailbox number combined.
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Mailbox prefixes
Mailbox prefixes are used by local users to address users at a remote site i
mailboxes at the remote site do not follow the dialing plan.

A mailbox prefix must be provided if the mailbox does not follow the dialing
plan or if another dialing plan, such as PSTN, is used.

A mailbox prefix does not have to overlap with local mailbox numbers. Two
mailbox prefixes can be entered. Either prefix can be used to address any 
mailbox at the local site. Normally, however, only one prefix is required.

Usually, the mailbox prefix is a shortcut. A mailbox prefix can be any numbe
long as it does not conflict with other network data.

A mailbox prefix can also be the entire telephone number of the site, includ
country code, city/area code, and exchange.

Example: If the mailbox prefix is 22 and the mailbox number of a local user
6565, users at other switches address the local user by dialing 226565.

Dialing prefix
A dialing prefix is needed if the local site uses another dialing plan, such as
PSTN, and users at your local site use dialing prefix to reach users at this re
site.

Usually, if the Dialing prefix box is enabled, you enter the prefix.

In a few cases, a dialing prefix is not needed. For example, if the mailbox 
number, without the mailbox prefix, can be dialed directly, a dialing prefix is 
needed. This situation is rare because most systems use at least some sor
access code.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To configure a remote prime switch location

1 In the Messaging Network Configuration tree view, select the remote prime 
switch location.

2 On the File menu, select Properties.

Result: The Remote Prime Switch Location Properties dialog box appears.
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3 On the General tab, in the Name box, enter the name of the remote prime 
switch location.

4 In the Description box, enter details about the switch location.

Note: The Enterprise Location ID is always set to 0 for remote prime switch 
locations and cannot be changed.

5 If needed, click Record to record a spoken name for the site, or click Import 
to import a prerecorded spoken name.

Note: For instructions on how to record a spoken name, see Recording a 
spoken name on page 211.

For instructions on how to import a spoken name, see Importing a spoken 
name on page 213.

6 Specify the dialing plan used to dial the remote site. Select the

■ ESN check box if ESN is used

■ CDP check box is CDP is used

■ ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if you use another dialing plan, such as 
PSTN.

7 Indicate if mailbox addressing follows the dialing plan.

8 If necessary, enter the mailbox prefix or prefixes.

9 If necessary, enter the dialing prefix.

ESN information
If the remote prime switch location uses an ESN or hybrid dialing plan, 
complete the ESN tab.

The procedure for configuring the ESN information for a remote prime switc
identical to the procedure used for the local prime switch location.

Note: You must provide the ESN access code used at the remote site. Do n
enter the access code used locally.

For a review of the ESN access codes, ESN location codes, and overlap, co
Configuring ESN information on page 177.
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To configure the ESN information

1 Open Message Delivery Configuration > Switch Location > ESN tab.

2 Enter the ESN access code.
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3 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

4 In the Location Code box, enter the location code.

5 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the location code.

6 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes box on the ESN tab.

7 Repeat steps 3–6 for each ESN location code required.

8 When you have finished configuring the ESN information, determine if you 
must configure CDP information. If yes, click the CDP tab. If no, click Save.

What’s next?
If your remote prime switch location uses the hybrid dialing plan, click the C
tab to continue configuring the local prime switch location.

If the local prime switch location uses only the ESN dialing plan, click Save
validate the configuration information and save it to the network database.

. 
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CDP information
If a CDP dialing plan or a hybrid dialing plan is used to connect the local sit
the remote site, complete the CDP tab.

Configuring the CDP information for a remote prime switch location is identi
to configuring the local prime switch location.

For a review of the CDP steering codes and overlap, consult Configuring CDP 
information on page 181.
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To configure the CDP information

1 Open Message Delivery Configuration > Switch Location > CDP tab.

2 Click the Add New button.

Result: The New CDP Steering Code Properties dialog box appears.
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3 In the Steering Code box, enter the steering code.

4 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the steering code.

5 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Codes box on the CDP tab.

6 Repeat steps 2–5 for each CDP steering code required.

7 When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and added to the network database.

What’s next?
You have completed the configuration of the remote prime switch location.

Click Save to validate the information and save it to the network database.

The Remote Prime Switch Location Properties dialog box closes, and you re
to the Messaging Network Configuration tree view.
206 CallPilot



November 1998 Adding sites to Integrated AMIS Networking 

llite 

 is 
lly 

ging 

ote 

y the 
Configuring a remote satellite switch location

Introduction
If a remote site is an NMS site, you must add and configure each of its sate
switch locations. This information is saved to the local network database.

Although a prime switch location is added automatically when a remote site
added to the Messaging Network Configuration tree view, you must manua
add each satellite switch location of a remote NMS site.

Capacity
An NMS site can have up to 59 satellite switch locations.

Organization
When you add a satellite switch location, this location appears in the Messa
Network Configuration tree view. Satellite switch locations are listed 
alphabetically below the prime switch location.

Where to configure a satellite switch location
To configure a satellite switch location, complete the General tab of the Rem
Satellite Switch Location Properties dialog box.

You must also complete the tabs that correspond to the dialing plan used b
local site.

ESN tab
Complete the ESN tab if you use an ESN or hybrid dialing plan.

CDP tab
Complete the CDP tab if you use a CDP or hybrid dialing plan.
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Spoken Name Recorded
When local users compose a message to a remote satellite switch location 
the playback feature to hear who sent a message, the name of the switch lo
is played. 

If a spoken name is not recorded, local users hear the full DN, such as “Ma
64441234.” If a recording of the spoken name is available, local users hear
switch location name followed by the mailbox number, such as “Milan 1234
You can either record a message using the telephone or import a prerecord
WAV file.

When a recording of the spoken name is available, Yes appears in the Spo
Name Recorded box.

If you do not want your local users to hear the name of this satellite switch 
location when composing messages or using playback, do not record a mes
For example, if you are using CDP to transfer messages to the site and ma
numbers follow the dialing plan, you may feel that a spoken name is 
unnecessary.

Dialing plan interaction
The dialing plan boxes are dynamically enabled or disabled depending on t
choices made. Complete all enabled fields. 

See also
Configuring a satellite switch location for a remote site is  identical to 
configuring a remote prime switch location for a remote site. 

For a review, consult Configuring a remote prime switch location on page 196.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure a remote satellite switch location

1 On the Messaging Network Configuration tree view, highlight the remote 
messaging server.

2 On the File menu, select New > Switch location.

Result: The Satellite Switch Location Properties dialog box appears.

3 In the Satellite Switch Location Properties dialog box, complete the General 
tab.

Note: For detailed instructions on how to record a spoken name, consult 
Recording a spoken name on page 211. For detailed instructions on how to 
import a spoken name, consult Importing a spoken name on page 213.

4 Complete the ESN tab and the CDP tab as required.
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5 Click Save.

Result: The information is validated and the satellite switch location is 
added to the remote site.

6 Repeat steps 1–5 for each satellite switch location required.

7 When all satellite switch locations are added, click Save to save them to the 
Messaging Network Configuration tree view.
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Recording a spoken name

Introduction
You can create a recording of the name of a switch location. A recorded nam
heard by a local user whenever an address is played back. A recorded nam
site is played if a user does not have a personal recorded name.

Local switch location
If your local site is not an NMS site, a spoken name is not required for the l
site.

If your local site is an NMS site, you can decide if you want to record a spo
name. For example, if the NMS site uses CDP, you may decide a spoken na
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote

Importing a spoken name
If you do not want to record your own voice using the telephone, you can im
a prerecorded WAV file. See Importing a spoken name on page 213.
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Before you begin
A telephone serves as the microphone. Therefore, if you want to record a sp
name, a telephone must be available.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To record a spoken name

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to record a spoken name.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Record.

Result: The Specify Phoneset dialog box appears.

4 Enter the telephone number of the telephone to be used as a microphone 
and click Dial.

Result: The telephone rings and the Voice Recorder dialog box appears.

5 Answer the telephone.

6 In the Voice Recorder dialog box, click Record.

7 Speak the name of the site into the telephone.

8 Click Stop.

9 To review the recording, click Play.

10 If you are satisfied with the recording, click Done.
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Importing a spoken name

Introduction
You can import a prerecorded file of the name of a switch location. The 
recording is heard by a local user whenever an address is played back. A 
recording for a site is played if a user does not have a personal spoken nam

Local switch location
If your local site is not an NMS site, a spoken name is not required for the l
site.

If your local site is an NMS site, you can decide if you want to import a spok
name. For example, if the NMS site uses CDP, you may decide a spoken na
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote

Recording a spoken name
If you do not want to import a prerecorded spoken name, you can record yo
own voice message using the telephone. See Recording a spoken name on page 
211.

Before you begin
A prerecorded WAV file must be available. Check the quality of the recordin
before importing the file.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To import a prerecorded file

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to import a prerecorded file.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Import.

Result: The Open dialog box appears.

4 Select the WAV file, and click Open.

Result: The file is imported.

5 Close the Open dialog box.
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Non-CallPilot remote sites

Introduction
Integrated AMIS Networking can exchange messages between a CallPilot 
system and the following non-CallPilot remote systems:

■ a  Meridian Mail (Release 8 and later) system

■ a Norstar Voice Mail (Release 3 and later) system

Coordination
If a remote site is a non-CallPilot system, you must coordinate with the netw
administrator of that remote site to ensure that the systems are properly 
configured. You must share the standard information that is required betwe
any sites in a messaging network.

Example
The two sites must coordinate dialing plans and ensure that there are no con
in the configuration information.

Terminology
A change in terminology may cause some confusion.

In Meridian Mail and Norstar Voice Mail, the name is Virtual-Node AMIS 
Networking, rather than Integrated AMIS Networking is used. The two are 
identical products.

Adding and configuring the remote site
Adding a non-CallPilot remote site to the local network database is exactly 
same as adding a CallPilot remote site.

To configure the non-CallPilot remote site, you require no special informatio
You must only specify the server type on the Remote Messaging Server dia
box. The rest of the configuration is the same as the configuration of a Call
remote site.
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Server type
Specify the server type of a non-CallPilot system on the Messaging Networ
Configuration—Remote Server Properties—General tab.

Instructions for the remote administrator
For both Meridian Mail and Norstar Voice Mail systems, there are no specia
considerations that must be communicated to the remote network administ

You add the CallPilot site to the remote network database like any other rem
site. No special configuration is required.
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Meridian Mail remote sites

Introduction
Integrated AMIS Networking can exchange messages between a CallPilot 
system and a Meridian Mail (Release 8 and later) system.

Instructions for the remote Meridian Mail administrator
You add the CallPilot site to the network database like any other site. There
no special considerations that must be communicated to the remote networ
administrator.
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Norstar Voice Mail remote sites

Introduction
Integrated AMIS Networking can exchange messages between a CallPilot 
system and a Norstar Voice Mail (Release 3 and later) system.

Instructions for the remote Norstar Voice Mail administrator
You add the CallPilot site to the network database like any other site. There
no special considerations that must be communicated to the network 
administrator.
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Testing and backing up Integrated 
AMIS Networking

This chapter describes how to test the Integrated AMIS Networking 
configuration. The test suite determines if Integrated AMIS Networking wor
properly both locally and with remote sites.

This chapter also describes how to create a backup of your system to ensu
the configuration is not lost due to system failure.

In this chapter
Tests and backups 221
Integrated AMIS Networking Implementation and Administration Guide 219
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Tests and backups

In this section
Integrated AMIS Networking test suite 222

Call routing test 224

Local SDN test 225

Quick SDN test 227

Loopback test 229

End-to-end test 231

Backing up Integrated AMIS Networking 234
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Integrated AMIS Networking test suite

Introduction
After you configure CallPilot for Integrated AMIS Networking, test the syste

The Integrated AMIS Networking test suite tests every aspect of the system
any test fails, resolve the problem and retry the test before you continue.

Note: These tests are not intended to validate the AMIS compliance of a thi
party system. The tests assume that any system that you communicate wit
AMIS-compliant.

Test suite
The Integrated AMIS Networking test suite consists of five tests. Two tests 
local site tests, which verify that your local configuration is correct. Three te
are coordinated site tests, which verify that everything works properly at yo
site and at every remote site.

The following table lists the local site tests and describes their purpose:

The following table lists the coordinated site tests and describes their purpo

This local site test Determines if

call routing test ■ the local system can make outbound 
calls to other sites in the network.

■ the local system cannot make 
outbound calls to restricted sites on th
network.

local or quick SDN test ports on CallPilot are working properly,
and SDNs are defined correctly.

This coordinated site test Determines if

end-to-end test a remote system can receive message
from the local system.
222 CallPilot



November 1998 Testing and backing up Integrated AMIS Networking 

e 
tests.

e you 
te 

y, 

re 

ling 
ter 

eters. 
e 

 

Coordination
While you can perform local site tests independently, you must work with th
network administrators at each remote site to perform the coordinated site 

In some instances, the remote administrator must make preparations befor
can conduct the test. For example, to complete the loopback test, the remo
network administrator must create a loopback mailbox.

If a test is unsuccessful and you do not find the cause of the problem locall
work with the remote administrators to determine the cause of the problem.

For quick results
When you test your implementation of Integrated AMIS Networking, there a
two ways to ensure quick results:

■ Change the batch threshold to 1.

■ Tag a test message as an urgent priority message.

An urgent tag ensures quick results. You do not need to change the schedu
parameters to perform the tests and return them to their original settings af
you complete the tests.

Note: An urgent test message is handled according to set scheduling param
For example, if the urgent message hold time is five minutes, it may take fiv
minutes before the test message is sent.

loopback test the local system can receive messages
from the remote system.

This coordinated site test Determines if
Integrated AMIS Networking Implementation and Administration Guide 223
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Call routing test

Introduction
The call routing test determines if the local system

■ can make outbound calls to other sites using Integrated AMIS Network

■ cannot make outbound calls to numbers that are configured as restricte
the system

Before you begin
Ask the switch technician for the ACD/UCD agent and trunk printouts for th
switch.

To perform the call routing test

1 Use the ACD/UCD agent and trunk printouts to select an ACD/UCD agent.

2 Program a telephone to use the same NCOS and TGAR as the agent.

Note: For instructions, consult your switch documentation.

3 Dial a network address.

4 Repeat steps 1–3 for a number that you know should be restricted.

Example: Attempt to access a trunk directly.

Evaluating test results
The call routing test is successful if an outbound call goes through to the allo
system but is blocked to a restricted system.

If the test is not successful
If the call routing test fails or produces unexpected results, a switch technic
must check the switch settings that control routing and restrictions on calls.

What’s next?
After you successfully complete the call routing test, perform the local SDN 
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Local SDN test

Introduction
The local SDN test verifies that the local system can receive messages from
remote system. This test confirms that the SDN for Integrated AMIS 
Networking in the SDN Table is correct.

The quick SDN test can be substituted for the local SDN test. See Quick SDN 
test on page 227.

Note: The SDN for Integrated AMIS Networking is, by default, the same defa
used by AMIS Networking.

If Integrated AMIS Networking and AMIS Networking share an SDN with 
another service, send the message to that SDN when you enter the system 
number.

The SDN test consists of sending a message to a mailbox at your local site
address the message as if it is being sent to an Open AMIS site. You enter
system access number in dialable format. For this test, the system access n
consists of the following:

■ the access code required to dial out of the system

■ your local site’s number, including the exchange code and SDN

To perform the SDN test

1 Log in to CallPilot.

2 Press 75 to compose a message.

3 Enter the following:

■ the AMIS compose prefix

■ the system access number

■ # to indicate the end of the system access number
Integrated AMIS Networking Implementation and Administration Guide 225



Testing and backing up Integrated AMIS Networking  Standard 1.0

ssages.

.

N 
ssary 

g, 
4 Enter the local mailbox number on which you are currently logged, followed 
by #.

Result: The system responds with the following message: Open network 
user <mailbox number> at <system access number> .

5 Press # again to indicate the end of the list of recipients.

6 Press 5 to record a message.

7 Record the message.

8 Press # to stop the recording.

9 Tag the message as urgent.

10 Press 79 to send the message.

Result: The system responds with the following message: Message 
sent .

11 Log off.

Evaluating test results
The message is sent according to the scheduling parameters for urgent me

The test is successful if you receive the message you recorded.

The test is not successful if you receive a non-delivery notification message

If the test is not successful
If the SDN test is not successful, check the Integrated AMIS Networking SD
in the SDN Table. Review the SDN setup requirements and make any nece
adjustments.

See also
For an overview of setting up SDNs, consult the Advanced Administration 
Guide.

For a detailed discussion of setting up SDNs for Integrated AMIS Networkin
consult SDN Table and Integrated AMIS Networking on page 118.

What’s next?
After you successfully complete the SDN test, perform the loopback test.
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Quick SDN test

Introduction
The quick SDN test verifies that the local system can receive messages. Th
confirms that Integrated AMIS Networking is correctly configured in the SDN
Table.

The quick SDN test does not require the participation of a remote network 
administrator.

The local SDN test can be substituted for the local SDN test. See Local SDN test 
on page 225.

To perform the quick SDN test

1 Log in to CallPilot.

2 From your local telephone, enter the local SDN for Integrated AMIS 
Networking.

3 Listen for the system to answer the call.

4 Repeat these steps for every SDN used by Integrated AMIS Networking.

Evaluating test results
The quick SDN test is successful if the system answers and waits for a C-to
The system times out after approximately 20 seconds.

The test is not successful if any prompts are heard.

If the test is not successful
If the quick SDN test is not successful, check the Integrated AMIS Network
SDNs in the SDN Table. Review the SDN setup requirements and make an
necessary adjustments.
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See also
For detailed information on setting up SDNs, consult the Advanced 
Administration Guide.

What’s next?
After you successfully complete the quick SDN test, perform the loopback t
228 CallPilot



November 1998 Testing and backing up Integrated AMIS Networking 

mote 

base.

 
ge to 

ilbox 

g 
 of 

st.
Loopback test

Introduction
A loopback test confirms that a message can be sent from a local site to a re
site, and returned to the local site.

You should perform this test after you add each remote site to the local data

To perform the loopback test, compose and send a message to a loopback
mailbox at a remote site. A loopback mailbox automatically returns a messa
the originator.

Before you begin
Before you perform the loopback test, you must ensure that a loopback ma
exists on each remote site tested.

Loopback mailbox
A loopback mailbox is a mailbox that is set up on every site in the messagin
network. The only purpose of a loopback mailbox is to return a confirmation
receipt.

Get the loopback mailbox number from the network administrator of each 
remote site with which you are performing the Integrated AMIS loopback te

To perform the loopback test

1 Log in to CallPilot.

2 Press 75 to compose a message.

3 Enter the network address of the remote site.

4 Enter the loopback mailbox number of the remote site.

5 Press 5 to record a message.

6 Record the message, and press # to stop recording.

7 Tag the message as urgent.

8 Press 79 to send the message.
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9 Wait for your Message Waiting Indicator light to activate.

Note: This light indicates that the message was successfully returned to 
you. Activation may take several minutes.

10 Log in and listen to the message.

11 Log out of the system.

Evaluating test results
The test is successful if you hear the message that you recorded.

The message is not successful if you receive a non-delivery notification 
message.

If the test is not successful
If the test is not successful, do the following:

■ Check with the remote network administrator and confirm the loopback
mailbox number.

■ Perform the test again to ensure that the message was addressed corr

■ Consult the operational measurement reports to determine the followin

● Are the connection DNs correct?

● Is the remote site operational?

● Do the message transfer protocols match?

What’s next?
After you successfully complete the AMIS loopback test, perform the end-to
end test.
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End-to-end test

Introduction
An end-to-end test verifies that users at a remote site can receive message
users at the local site.

To perform the end-to-end test, send a message to a mailbox at a remote s
Send the test message to the mailbox of the remote network administrator 
request a confirmation.

Before you begin
You must coordinate with the remote network administrator of each site wit
which you wish to perform a loopback test. Each remote administrator mus
listen to the message you have sent before returning an acknowledgment.

To perform the end-to-end test

1 Log in to a mailbox.

2 Press 75 to compose a message.

3 Enter the mailbox address for a mailbox at a remote site.

4 Press #.

5 Press # again.

6 Press 5 to record a message.

7 Record the message, and then press # to stop the recording.

8 Tag the message as urgent.

9 Press 79 to send the message.

10 Log out of the system and hang up.

11 Ask the remote administrator to log in to the mailbox and listen to the 
message.

12 Wait for an acknowledgment to be returned to you.

13 Log in to the mailbox and listen to the acknowledgment.
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Evaluating test results
The test is successful if the message is successfully delivered to the remot
system.

The test is not successful if a non-delivery notification (NDN) is received, wh
indicates that the message was not received.

Confirming successful delivery
Even if you do not receive an NDN, you may want to confirm that the mess
was successfully delivered.

To confirm the delivery, either

■ log on to the remote site and read the message, or

■ ask the administrator at the remote site to log on and read the messag

If the test is not successful
If the end-to-end test fails or produces unexpected results, check the follow

■ Was the message correctly addressed?

■ Does the mailbox on the remote system exist?

■ Does the NDN provide any indication of the problem?

If you receive an NDN, listen to the message to determine why the test
message was not delivered.

IF the NDN states THEN

it took too many attempts to send 
the message

the cause may be

■ incorrect message transfer protocol.

■ incorrect site ID.

■ incorrect connection DN.

■ incorrect passwords.

■ the remote site is disabled.
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■ Do the Alarm and Event reports provide details of the possible causes?

Since all previous tests have been successfully completed, the remote
probably caused the test to fail.

Examples of remote site causes include the following:

● Incorrect password pairs were assigned between sites.

● Channels were not available.

● Addresses were incorrect.

● Connection DNs do not terminate on the networking DN.

● A remote site that is not yet operational was specified.

What’s next?
The end-to-end test is the final test in the Integrated AMIS Networking test 
suite. When you successfully complete the end-to-end test, perform a back
your configuration.

the address was incorrect the message was delivered to the remot
but could not be delivered. The cause may
be

■ the mailbox does not exist.

■ the wrong mailbox number was used.

■ the Receive Composed Messages box o
the Class of Services screen is set to N

■ the disk at the remote site is full.

IF the NDN states THEN
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Backing up Integrated AMIS Networking

Introduction
When all tests of the system are successfully completed and Integrated AM
Networking is working properly, perform a backup.

The backup ensures that the configuration is not lost due to system failure.

Backup schedule
Perform a manual backup as the final step in the AMIS Networking installat

Note: You must perform a manual backup even if the system is configured 
perform an automatic backup. 

In the unlikely event that the system experiences a disk failure before the 
automatic backup takes place, the networking configuration could be lost.

Whenever you modify Integrated AMIS Networking information during regul
maintenance, perform a backup.

System backup components
A system backup consists of two parts:

■ switch backup

■ CallPilot backup

Switch backup
For detailed instructions on how to perform a switch backup, consult your 
switch documentation.

CallPilot backup
You can perform a full or partial backup of your CallPilot server. For detaile
instructions on how to perform a CallPilot backup, consult the Advanced 
Administration Guide.
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Maintaining Integrated AMIS 
Networking

After you complete the Integrated AMIS Networking implementation, you on
need to perform regular maintenance. 

This chapter describes maintenance procedures that must be performed 
regularly. The chapter also describes maintenance procedures that you per
only when required.

In this chapter 
About maintaining Integrated AMIS Networking 237

Regularly scheduled maintenance tasks 243

As-required maintenance tasks 245
Integrated AMIS Networking Implementation and Administration Guide 235
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About maintaining Integrated AMIS 
Networking

In this section
Overview 238

Maintain a network history 240

Printing configuration information 241
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Overview

Introduction
After you successfully install and test Integrated AMIS Networking, the syst
only requires maintenance. You need to perform two types of maintenance 

■ regularly scheduled

■ as-required

Regularly scheduled tasks
Regularly scheduled tasks include

■ checking the network status

■ reviewing Operational Measurement (OM) reports

Although you can perform regularly scheduled tasks at any time, perform th
tasks at least once a week. Since these tasks do not interfere with the oper
of  Integrated AMIS Networking, you can schedule them at a convenient tim
during a regular workday.

If you monitor the performance of your messaging network, you avoid futur
problems. Careful monitoring shows bottlenecks in the system and indicate
how the system can be improved.

Monitoring can also help you to plan and forecast future messaging networ
requirements.

As-required tasks
Perform as-required tasks as needs arise. As-required tasks include

■ modifying networking parameters

■ disabling and enabling Integrated AMIS Networking

■ modifications to the Integrated AMIS Networking configuration
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When to perform as-required tasks
Since as-required tasks may affect the entire system, perform these tasks w
the system is not in heavy use.

Modifications to the configuration may be necessary for the following reaso

■ New legal delivery times are announced for computer-generated calls.

■ The system performance suggests that adjustments to the parameters
required.

■ The system access number is changed.

Perform a backup following maintenance
Perform a backup of the system whenever you modify the network paramete
part of your maintenance.

ATTENTION! Because as-required tasks may affect the performance
the entire system, schedule them for off-peak hours.
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Maintain a network history

Introduction
Keep detailed records of your network’s history. These records can

■ Indicate significant performance or equipment issues that real-time 
monitoring may not detect.

■ Provide a background for comparing the current information.

■ Provide information needed during support calls.

Information to record
A network history should contain the following types of information:

■ installation dates and descriptions

■ contact information for all key personnel involved in the system installat
and configuration

■ details of software installed on the messaging server, including version

■ installation process and results, including tests

■ diagrams of the initial and subsequent network configurations

■ any problems encountered and their solutions

■ hardware and software changes

■ changes to the messaging network layout

Where to keep the records
Make the records of your messaging network easy to access and easy to re
Graphics, including hand-drawn sketches, can be very useful.

Keep records in a log or online. Note, however, that online records cannot b
accessed if the system fails.

See also
For a detailed description of messaging network histories, consult the 
Networking Planning Guide.
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Printing configuration information

Introduction
Printouts of the system configuration are often included in a network history
You can print all configuration information contained in your local network 
database.

To print configuration information, you must open the relevant Properties dia
box. For example, to print an item in the Messaging Network Configuration 
view, you must open the Properties dialog box of the item.

If a Properties dialog box consists of more than one tab, the contents of all 
are printed.

Note: You cannot print the tree view of the messaging network contained in
Messaging Network Configuration dialog box.

When to print configuration information
Although configuration information is always available in the most recent 
backup of your network database, you may find it convenient to make printo
as well.

Printouts of the configuration information are especially useful in the followi
situations:

■ You must fax information to a remote network administrator.

■ You are keeping a network history.

■ You are planning to change a configuration or delete an item from the 
Messaging Network Configuration tree view, and you want a hard copy
the original configuration.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration or Messaging 
Network Configuration

To print configuration information

1 Open the dialog box that you want to print.

2 With the dialog box open, click the Print button.

Result: The contents of the dialog box print. The printout includes the 
contents of all tabs.
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Regularly scheduled maintenance tasks

In this section
Reviewing OM reports and alerts 244
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Reviewing OM reports and alerts

Introduction
Operational Measurement (OM) reports show how much of the CallPilot sys
is being used by AMIS Networking.

Three OM reports provide AMIS Networking information:

Although you can review OM reports at any time, you should review them a
least weekly.

Access to OM reports is restricted
The generation of OM reports is a restricted activity that is determined by ac
level. If you do not have the necessary access, you must ask your system 
administrator to generate the reports.

The OM report request screens let you choose the reports that you want to
and print. For many reports, you can also customize the displayed results s
you receive the information in a format that best suits your needs.

See also
For more information on OM reports, including how to interpret them, consu
the Reporter Guide.

This OM report provides

Open Networking Activity information about open networking activity 
over a specified time interval.

Network Usage Bill-back information to bill back the cost of users’ 
networking activities.

Failed Networking Sessions 
alert

notification that the number of networking 
failures equals or exceeds the total number o
networking attempts.
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As-required maintenance tasks

In this section
Overview 246

Modifying the configuration of Integrated AMIS Networking 248

Disabling and enabling Integrated AMIS Networking 250

Modifying message delivery parameters 253

Modifying the channel resource allocation 255

Add, modify, or delete remote sites 257

Locating an item in the tree view 259

Modifying a remote site configuration 260

Deleting items in the tree view 263

Modifying dialing plan information 266
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Overview

Introduction
You may need to modify the Integrated AMIS Networking configuration, 
including

■ whether the system can send or receive AMIS messages

■ the time periods when outgoing messages are allowed to be sent durin
business and nonbusiness days

■ the minimum and maximum port allocation for AMIS Networking

■ how many messages to transmit in each AMIS Networking session

■ the scheduling parameters

Scheduling parameters
The scheduling parameters that may be modified are

■ economy message send time

■ stale times for economy, standard, and urgent messages

■ batch threshold

■ delivery days and times

Identifying required modifications
Changes to the Integrated AMIS Networking configuration may be required

■ Message delivery scheduling is not performing as anticipated.

■ There are changes to the long-distance charge period or to delivery da
and times.

■ There are changes to network traffic to and from Open AMIS sites.
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Example 1
When you originally configured the system, you set the economy delivery s
time to 8:00 p.m. and the stale time to 4 hours. Users find that many of thei
messages are going stale and are being returned with non-delivery notifica

A coordination problem exists between the two scheduling parameters. If y
compose an economy message in the morning, it may go stale before the 
delivery time begins. Therefore, you must reconfigure the stale time to 20 ho
for example. This reconfiguration ensures that messages can be composed
throughout the business day and will not go stale before the delivery begins

Example 2
When you originally configured Integrated AMIS Networking, the lower rate
for long distance came into effect at 11:00 p.m. Therefore, you set the econ
delivery start time to 11:00 p.m.

However, the telephone company has announced new periods for lower lon
distance toll rates. Lower rates now begin at 8:00 p.m. Therefore, you chang
economy delivery start time to 8:00 p.m.
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Modifying the configuration of Integrated 
AMIS Networking

Introduction
If you need to modify the Integrated AMIS Networking configuration, follow 
these general guidelines.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > AMIS 1 or AMIS 
2 tab

To modify the Integrated AMIS Networking configuration

1 Review Chapter 5, Configuring CallPilot for Integrated AMIS Networking, to 
ensure that you understand the impact of the changes.

2 Enter all required modifications on the AMIS 1 and AMIS 2 tabs.

3 Click Save.

Result: The system validates the modifications and, if they are valid, puts 
the modifications into operation immediately.

CAUTION!
. 

Risk of loss of functionality
Changes to the networking configuration should be done 
during hours when users are not logged on. Making chang
to the configuration while users are logged on may result 
loss of messaging functionality.
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Announce some modifications
Most of the modifications that you make to the Integrated AMIS Networking
configurations are transparent to your users. Although modifications may a
the performance of the system, they do not require any new input from use

However, if you modify the AMIS compose prefix, you must announce this 
change to all local users.

If you modify the SAN, you must notify remote callers about this change. Al
remind your local users to tell users at the open sites about the changes.

Perform a backup
After you modify the configuration of Integrated AMIS Networking, perform 
backup to ensure that these changes are not lost.

Also record the changes in your network history.
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Disabling and enabling Integrated AMIS 
Networking

Introduction
You may need to disable Integrated AMIS Networking occasionally. When y
disable Integrated AMIS Networking, users cannot compose, send, or rece
AMIS messages.

You might disable Integrated AMIS Networking to

■ Prevent system abuse.

■ Temporarily suspend outgoing or incoming messages, or both.

Messages sent while system is disabled
When you disable outbound Integrated AMIS Networking, your local users 
continue to compose and send messages. The messages composed by yo
users are held in queue until the option is enabled or the message become

When you disable inbound Integrated AMIS networking, messages from rem
systems are rejected. The remote system that sends the message is inform
the status, and messages are not accepted. The way the remote system ha
this information depends on the system. For example, if the remote system
CallPilot, the sender receives a non-delivery notification that states that the
system of the intended recipient is not accepting messages. AMIS-complia
systems from other vendors may handle this scenario differently.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > AMIS 1 tab

To disable and enable Integrated AMIS Networking

1 Do the following:

2 To save your settings, click Save.

Other ways to disable and enable Integrated AMIS Networking
There are several ways to disable and enable Integrated AMIS Networking.
the most appropriate method, depending on the circumstances.

In addition to the Message Delivery Configuration method described above
following methods are available:

IF you want to THEN

disable your system from receiving 
AMIS messages

clear the Incoming AMIS 
Networking check box.

disable your system from sending AMIS 
messages

clear the Outgoing AMIS Networking 
check box.

enable your system to receive AMIS 
messages

select the Incoming AMIS 
Networking check box.

enable your system to send AMIS 
messages

select the Outgoing AMIS 
Networking check box.

IF you want to THEN

disable the sending and receiving 
of Integrated AMIS Networking 
messages by user class of service

set this option in Basic Administration.

disable or restrict the sending of 
Integrated AMIS Networking 
messages to specific or all SANs 
by a user

change the AMIS Restriction/Permission 
List for the user.
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disable the sending of messages 
to any remote site, using any 
protocol, by the local server

clear the Send Messages to all other Serve
option in the Messaging Network 
Configuration dialog box for the local 
server.

Note: This option is available only if 
additional networking solutions are 
installed on your local system.

disable the sending of messages, 
using the defined protocol, to a 
specific remote site

clear the Send Messages to all other Serve
option in the Messaging Network 
Configuration dialog box for the remote 
server.

Note: This option is available only if 
additional networking solutions are 
installed on your local system.

IF you want to THEN
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Modifying message delivery parameters

Introduction
Message delivery parameters control when and how Integrated AMIS 
Networking sends messages. You can modify the following message delive
parameters as required:

■ batch threshold

■ stale times

■ AMIS compose prefix

■ economy delivery start and stop times

■ AMIS delivery times

Impact of modifications
The message delivery parameters are closely interrelated. Modifications to
parameter may necessitate changes to others. Therefore, carefully plan 
modifications in advance.

You must test and monitor the performance of the system after you make a
modifications to ensure that the modifications have the desired effect and n
unplanned side effects.

Note: Before you modify the message delivery parameters, review the prev
discussion of how these parameters are set. Review Chapter 5, Configuring 
CallPilot for Integrated AMIS Networking.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > AMIS 1 and 
AMIS 2 tabs

To modify message delivery parameters

1 Modify the delivery parameters on both tabs as required.

2 Review the changes to ensure that there are no conflicts among the 
parameters.

3 Click Save.

Perform a backup
After any modification to the configuration, perform a backup to ensure that
modification is not lost.
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Modifying the channel resource allocation

Introduction
When you implemented Integrated AMIS Networking, you set the minimum a
maximum channel resource allocation for both the inbound and the outboun
Integrated AMIS Networking SDNs. The channel resources determine how
efficiently services are accessed.

Balance channel resources
You must carefully balance channels for each service when you allocate cha
resources. You must allocate enough channels to ensure that users can acc
service. However, you must not overallocate channels so that users are una
access other services.

Determine if modifications are necessary
To determine if modifications to the channel resource allocation are necess
monitor service usage. After Integrated AMIS Networking is in service for a
period of time, use the Reporter feature to determine how services are bein
used.

Reporter provides the following statistics:

■ the number of calls queued for a service

■ the average wait time for queued calls

■ the maximum wait time for queued calls

■ the number of callers who abandoned the queue

If you are dissatisfied with the performance of Integrated AMIS Networking 
after analyzing these statistics, modify the resource allocation. However, 
remember that modifications to the resource allocation for one service may
affect the performance of other services.
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Getting there  Nortel SMI > Meridian Application Server > System 
Configuration > Service Administration > Service Directory 
Number > Service Directory Number Table

To modify an SDN

1 In the SDN Table, select the SDN you want to modify.

2 On the File menu, select Properties.

Result: The Edit Service Directory Number Properties dialog box appears.

3 Make the necessary modifications.

4 Click Save.
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Add, modify, or delete remote sites

Introduction
As your messaging network grows and changes, you may need to add, mo
or delete a remote site.

Note: It is very important that all network administrators keep the information
their network database up-to-date.

Before you begin
Before you add, modify, or delete a remote site, print all configuration 
information that will be affected.

Add a remote site
When you add a site to the messaging network, all sites add the new site to
Messaging Network Configuration tree view. The remote administrator mus
provide the information necessary to add and configure a remote site.

Modify a remote site
You can modify the configurations of both the messaging server and the sw
locations as needs change. For example, if a remote site upgrades its syste
must modify its configuration information in your network database.

It is important that the information in your network database reflect the actu
configuration of the remote site. The remote network administrator must info
you of all necessary changes.
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Delete a remote site
When you remove a site from the messaging network, all sites must delete
from their Messaging Network Configuration tree view.

Impact on network database
Your network database reflects any additions, modifications, or deletions to
remote sites. For this reason, you should perform the Integrated AMIS 
Networking test suite again, as well as a backup.
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Locating an item in the tree view

Introduction
It can be difficult to locate a particular remote site, messaging server, or sw
location in the Messaging Network Configuration tree view in a large messa
network.

There are two ways to locate an item in a large messaging network:

■ Scroll through the alphabetized list.

■ Use the Find feature.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To locate an item using Find

1 On the File menu, select Find.

Result: The Find dialog box appears.

2 Enter the name of the item to be located, and press the Find button.

Result: The located item is highlighted in the Messaging Network 
Configuration tree view.
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Modifying a remote site configuration

Introduction
Modify the configuration of a remote site as required.

To modify a remote site, you must open the Messaging Network Configurat
tree view and select the remote messaging server or switch location that yo
wish to modify.

Further information
Make modifications to the configuration on the Properties dialog box where
initial configuration was made. To review the settings, consult the instructio
for the initial configuration.

Impact of modifications
When you modify the configuration of a remote system,  networking service
between the remote site and your local site may be affected. Modifications t
following settings are especially important:

■ site IDs

■ connection DN

■ dialing plans

■ message transfer protocol

To review the settings on this 
Properties dialog box Consult the instructions found here

Remote Messaging Server Configuring a remote messaging server 
on page 187.

Remote Prime Switch location Configuring a remote prime switch 
location on page 196.

Remote Satellite Switch Location Configuring a remote satellite switch 
location on page 207.
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Enterprise Site IDs
Do not change the remote Enterprise Site ID unless the administrator at the
remote site notifies you of a change in that ID, or if the ID is incorrect.

If you change the site ID to an invalid number by mistake, the system is una
to send or receive messages from the site.

Connection DN
Do not change the connection DN to a remote site unless

■ the administrator at the remote site notifies you that the DN in the SDN
Table is changed, or

■ you are changing the message transfer protocol

Dialing plans
Do not change the dialing plan unless the dialing plan on the switch is chan

Network protocol
Do not change the network protocol configured for a remote site unless the
network administrator of the remote site advises you to do so. Changing the
network protocol used between two sites requires considerable reconfigura
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To modify the configuration of a remote site

1 In the Messaging Network Configuration tree view, select the remote 
messaging server or servers that you want to modify. 

2 On the File Menu, select Open.

Result: The Properties dialog box for the selected item opens.

3 Make all required modifications.

4 Click Save.

Result: The modifications are validated and saved to the network 
database.

5 Repeat steps 1–4 for all items in the tree view that must be modified.

After modifications are complete
You must test modifications to the configuration of a remote site. Complete
test suite to ensure that the modifications work properly.

When you are satisfied that your system is working properly, perform a bac
262 CallPilot



November 1998 Maintaining Integrated AMIS Networking 

 site 

 

your 

es 

rk 

 

 it 

f 
Deleting items in the tree view

Introduction
The Messaging Network Configuration tree view contains all sites in your 
messaging network with which the local site exchanges messages.

A site always consists of a messaging server and a prime switch location. A
may also include satellite switch locations.

Sites and satellite switch locations are deleted from the Messaging Network
Configuration tree view.

Note: You cannot delete the local site. You can delete local satellite switch 
locations.

Multi-administrator environments
If several administrators maintain your local network database, ensure that 
view of the Messaging Network Configuration tree view is up-to-date. The 
Messaging Network Configuration tree view is updated when it is initially 
opened. An open tree view is not updated when another administrator mak
changes.

To check the status of the view
To see if another administrator has made changes to the Messaging Netwo
Configuration tree view, on the View menu, click Refresh.

ATTENTION! When an item is deleted from the Messaging 
Network Configuration tree view, it is permanently
removed from the local network database. The 
information cannot be recovered. For this reason,
is strongly recommended that you print out the 
complete configuration of all items to be deleted. I
an item is accidentally deleted, you can use the 
printed information to add the item again.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To delete a remote site

1 Print the configuration details of the site that you want to delete.

2 Open the folder of the remote site to see the messaging server, prime 
switch location, and any satellite switch locations.

3 In a multi-administrator environment, on the View menu, click Refresh.

4 Highlight the messaging server of the site that you want to delete.

5 Select File > Delete.

Result: A confirmation message appears asking if you really want to delete 
the site from your local network database.

6 To delete the site, click Yes.

Tip: You can also delete a highlighted remote site by clicking the Delete 
button.

Deleting several remote sites at once
If you must delete several remote sites from the local network database, you
find it more efficient to delete all the sites at once.

To delete several remote sites at once

1 Print the configuration details of all the sites that you want to delete.

2 In the tree view, highlight all the remote sites that you want to delete.

Tip: To select more than one item in the tree view, press Ctrl and right-click 
the mouse.

3 Select File > Delete.

Result: A confirmation message appears. 

4 Click Yes to delete the sites. Click No to keep the sites.
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Deleting a satellite switch location
If there are changes to an NMS site, you can delete one or more satellite sw
locations from the local site or from any remote sites.

If you remove a satellite switch location from an NMS site, you must also 
remove it from the local network database.

To delete a satellite switch location  
Print the configuration details of the satellite switch location.

1 In a multi-administrator environment, on the View menu, click Refresh.

2 Highlight the satellite switch location that you want to delete.

3 On the File menu, click Delete.

Result: A confirmation message appears. 

4 Click Yes to delete the sites. Click No to keep the sites.
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Modifying dialing plan information

Introduction
After you establish a dialing plan, you rarely modify it. Modifications to a 
dialing plan affect users and may require considerable relearning of the sys

However, if modifications are necessary, they are usually guided by change
made by the switch technician. These changes can be local or remote.

Switch changes
If any changes to the dialing plan are made on a switch,  the network datab
of the sites in the messaging network must reflect these changes. If change
made locally, ensure that all remote sites are notified.

To modify the dialing plan information
If you need to modify the dialing plan, follow the general instructions to mod
the local and remote sites.

Modifying CDP steering codes
Modifications to the CDP steering codes are more complicated. For a detai
review of how to plan for and implement changes, consult Chapter 4, “Diali
plans and networking,” in the Networking Planning Guide.
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Troubleshooting Integrated AMIS 
Networking

Although testing and regular maintenance ensure that Integrated AMIS 
Networking is working properly, the system may experience occasional 
problems.

This chapter describes how to diagnose and correct these problems.

In this chapter
About troubleshooting Integrated AMIS Networking 269

Determining if problems are switch-related 275
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About troubleshooting Integrated AMIS 
Networking

In this section
Overview 270

Determine if Integrated AMIS is disabled 272

Reviewing Alarm and Event reports 273

Reviewing Operational Measurement reports 274
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Overview

Introduction
If you are experiencing problems with Integrated AMIS Networking, this 
chapter will help you to identify and solve these problems.

Common causes of Integrated AMIS Networking problems include the 
following:

■ Integrated AMIS Networking is disabled.

■ The status of a remote site prevents it from receiving messages from t
local site.

■ Networking configuration is incorrect or incomplete.

■ The switch is configured incorrectly.

■ There are hardware problems.

Identify the source of the problem
To identify the source of the problem, first determine if Integrated AMIS 
Networking is disabled.

If Integrated AMIS Networking is properly enabled, then review the followin

■ appropriate Alarm and Event reports

■ network status

■ Operational Measurement (OM) reports

Configuration errors
Configuration errors may include the following:

■ incorrect connection DNs

■ message transfer protocols that do not match between the remote and
sites

■ incorrect dialing plan information, including ESN prefixes and CDP 
steering codes

■ scheduling parameters that need to be modified
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Site status errors
A site can be either intentionally disabled or put into error status.

A remote site may be put into error status because of unsuccessful attempt
the local site to deliver messages to the remote site. Failed message delive
happen for the following reasons:

■ The remote site is experiencing hardware or software problems.

■ There are site configuration errors.

Switch-related problems
If you are unable to identify the problem using CallPilot, the error may be 
switch-related. Perform the call trace test to determine if there is a problem 
the switch configuration.

Call trace
Call trace helps you to determine if network calls are being blocked for one
more of the following reasons:

■ Digit manipulation is performed incorrectly. Either not enough or too ma
digits are inserted or deleted.

■ Class of service restrictions are either too stringent or too loose.

■ Dialing is incorrect. More digits are required by the trunks or trunk route

Note: On the switch, you can perform a call trace on a telephone or on a tru
and a trunk route.

Hardware problems
If you are unable to locate the problem in the CallPilot networking configurat
or in the switch, your system may be experiencing hardware problems that
not related to networking.

Perform a basic hardware check. Examine all connections.
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Determine if Integrated AMIS is disabled

Introduction
You must enable Integrated AMIS Networking to receive incoming AMIS 
messages and to deliver outgoing AMIS messages.

Begin any troubleshooting session by determining if Integrated AMIS 
Networking is properly enabled.

There are several methods of disabling and enabling the sending and recei
of Integrated AMIS Networking messages. 

To determine if Integrated AMIS Networking has been disabled to receive 
incoming messages or to send outgoing messages, or both, check the setti
the AMIS 1 tab of the Message Delivery Configuration dialog box.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration

To determine if Integrated AMIS Networking is disabled

1 From the Message Delivery Configuration dialog box, select the AMIS 1 
tab.

2 Check the settings of the Outgoing AMIS Networking and Incoming AMIS 
Networking check boxes. Ensure that these check boxes are selected as 
required for your system.

3 Click Save to exit and save any changes that you made.

If Check this setting

the system does not receive 
incoming messages

Incoming AMIS Networking messages enabled

the system does not deliver 
outgoing messages

Outgoing AMIS Networking messages enabled
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Reviewing Alarm and Event reports

Introduction
Alarm and Event reports track and report system errors and unusual events
These reports can be viewed on-screen or printed, or both.

Reports related to Integrated AMIS Networking
The following reports are useful for monitoring Enterprise Networking:

■ Networking Activity report

■ Network Usage Bill-back report

■ Failed Networking Sessions alert

See also
For instructions on reviewing and interpreting Alarm and Event reports, con
the Reporter Guide.
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Reviewing Operational Measurement reports

OM reports
Operational Measurement (OM) reports contain detailed information on how
system is functioning. When you attempt to locate problems with Integrated
AMIS Networking, review these reports.

When you review the OM reports, consider the following:

See also
For detailed instructions on producing, reviewing, and interpreting Operatio
Measurement reports, consult the Reporter Guide.

This OM result Suggests

large number of accesses the holding time may be too low, or the batch thresh
too small.

excessive “Failed to Send” 
messages

the remote system may be down, or the dialing 
translations are incorrectly configured, or the call 
maximum number is too small.

high number of NDNs users are entering incorrect addresses, or mailboxes d
exist on the remote system.

networking traffic is 
excessive

an unusual or cyclical event affected the system, or the
number of channels used by Integrated AMIS Networkin
is too small, or the number of channels available to 
Integrated AMIS Networking is too small.

failures the remote system does not support the AMIS protocol,
the number of channels is too small.
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Determining if problems are switch-
related

In this section
Switch-related problems 276

Call trace test 277

Link diagnostic test 279
Integrated AMIS Networking Implementation and Administration Guide 275



Troubleshooting Integrated AMIS Networking  Standard 1.0

ing 
Switch-related problems

Integrated AMIS Networking problems and the switch
If you cannot identify the cause of the Integrated AMIS Networking errors us
CallPilot, the problem may be switch-related.

The following tests identify switch-related problems:

■ call trace

■ link diagnostic
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Call trace test

Purpose
If you cannot identify the Integrated AMIS Networking problem using CallPilo
calls may be blocked by the switch. The call trace test determines

■ if calls are blocked

■ why calls are blocked

Why calls are blocked
A network call can be blocked for one or more of the following reasons:

■ Digit manipulation is performed incorrectly. Not enough or too many dig
are inserted or deleted.

■ Class of service restrictions are too stringent or too loose.

■ Dialing is incorrect. More digits are required by the trunks or card trunk
routes.

Where a call trace is performed
On the switch, you can perform a call trace on a phoneset or on a trunk and 
route.

Before you begin
To interpret the results of a call trace test, you need to understand

■ how the switch processes calls

■ how to interpret the results of a call trace session

Note: A switch technician should perform the call trace test and interpret the
results.
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The information that is required to perform the call trace test varies for each 
of switch. However, the following information is usually required:

■ your customer number

■ the directory number that will be tested

■ the type of telephone and key number (for multiline telephones)

■ the terminal number (loop, shelf, card, unit) of the telephone or trunk th
will be tested

■ the route type and trunk number of the trunk and trunk route that will b
tested

To perform the call trace test
Follow the instructions in your switch documentation.

How to interpret the results
For guidelines on how to interpret the results of the call trace test, consult y
switch documentation.
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Link diagnostic test

Purpose
If you cannot identify the cause of the networking problem on the CallPilot or
performing the call trace test, the problem may not be related to networking

The link diagnostic test determines if the link between the switch and the 
Meridian Application Server is working.

Before you begin
The link diagnostic must be performed by a switch technician.

To perform the link diagnostic test
Follow the instructions in your switch documentation.
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A
Add/Update Remote Users on this Server, 168

B
Batch Threshold, 141

C
CDP Steering Code

Overlap, 182
Prime Switch Location Properties dialog box, 

182
Remote Prime and Satellite Switch Location 

Properties dialog boxes, 204
Collect (number of) messages before sending 

(Batch Threshold), 141

D
Description

Local Messaging Server Properties dialog 
box, 167

Prime Switch Location Properties dialog box, 
173

Remote Messaging Server Properties dialog 
box, 189

Remote Prime and Satellite Switch Location 
Properties dialog boxes, 197

Dialing plans for dialing to this location
Prime Switch Location Properties dialog box, 

174
Remote Prime and Satellite Switch Location 

Properties dialog boxes, 199

E
Economy Integrated AMIS stale time, 141

Economy Open AMIS stale time, 141
Enterprise Location ID

Prime Switch Location Properties dialog box
173

Remote Prime and Satellite Switch Location
Properties dialog boxes, 198

Enterprise Site ID
Local Messaging Server Properties dialog 

box, 168
Remote Messaging Server Properties dialog

box, 191
ESN Access Code used by this location

Prime Switch Location Properties dialog box
178

Remote Prime and Satellite Switch Location
Properties dialog boxes, 201

ESN Location Code
Overlap, 179
Prime Switch Location Properties dialog box

178
Remote Prime and Satellite Switch Location

Properties dialog box, 201
Remote Prime and Satellite Switch Location

Properties dialog boxes, 201

I
Incoming AMIS Networking, 140
Integrated AMIS economy delivery start and 

stop times, 145
Integrated AMIS Networking connection DNs, 

193

L
Local Messaging Server Properties dialog box

168
Add/Update Remote Users on this Server, 1
Description, 167
Name, 167
Receive Message Text Info, 169
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Send Messages to all other Servers, 167
Server FQDN, 169
Server type, 167

M
Mailbox addressing follows dialing plan

Prime Switch Location Properties dialog box, 
174

Remote Prime and Satellite Switch Location 
Properties dialog boxes, 199

Mailbox prefixes
Prime Switch Location Properties dialog box, 

175
Remote Prime and Satellite Switch Location 

Properties dialog boxes, 200
Message Delivery Configuration dialog box, 140

Batch Threshold, 141
Collect (number of) messages before sending 

(Batch Threshold), 141
Economy Integrated AMIS stale time, 141
Economy Open AMIS stale time, 141
Incoming AMIS Networking, 140
Integrated AMIS economy delivery start and 

stop times, 145
Open AMIS compose prefix, 145
Open AMIS economy delivery start and stop 

times, 145
Outgoing AMIS Networking, 140
Private network Local AMIS System Access 

Number, 141
Public network Local AMIS System Access 

Number, 140

N
Name

Local Messaging Server Properties dialog 
box, 167

Prime Switch Location Properties dialog box, 
173

Remote Messaging Server Properties dialog 
box, 188

Remote Prime and Satellite Switch Location 
Properties dialog boxes, 197

Network protocol, 192

O
Open AMIS compose prefix, 145
Open AMIS delivery times, 146
Open AMIS delivery times dialog box, 146
Open AMIS economy delivery start and stop 

times, 145
Outgoing AMIS Networking, 140
Overlap

CDP Steering Code, 182
ESN Location Code, 179

P
Prime Switch Location Properties dialog box

CDP Steering Code, 182
Description, 173
Dialing plans for dialing to this location, 174
Enterprise Location ID, 173
ESN Access Code used by this location, 17
ESN Location Code, 178
Mailbox addressing follows dialing plan, 174
Mailbox prefixes, 175
Name, 173
Spoken Name Recorded, 174

Private network Local AMIS System Access 
Number, 141

Public network Local AMIS System Access 
Number, 140

R
Receive Message Text Info, 169
Remote Messaging Server Properties dialog b

Description, 189
Enterprise Site ID, 191
Integrated AMIS Networking connection 

DNs, 193
Name, 188
Network protocol, 192
Send local user information to this Server, 19
Send Message Text Info to this Server, 191
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Send Messages to this Server, 189
Server FQDN, 191
Server type, 189

Remote Prime and Satellite Switch Location 
Properties dialog boxes

CDP Steering Code, 204
Description, 197
Dialing plans for dialing to this location, 199
Enterprise Location ID, 198
ESN Access Code used by this location, 201
ESN Location Codes, 201
Mailbox addressing follows dialing plan, 199
Mailbox prefixes, 200
Name, 197
Spoken Name Recorded, 198

Remote Satellite Switch Location Properties 
dialog box

See also Remote Prime and Satellite Switch 
Location Properties dialog boxes

Spoken Name Recorded, 208

S
Send local user information to this Server, 190
Send Message Text Info to this Server, 191
Send Messages to all other Servers, 167
Send Messages to this Server, 189
Server FQDN

Local Messaging Server Properties dialog 
box, 169

Remote Messaging Server Properties dialog 
box, 191

Server type
Local Messaging Server Properties dialog 

box, 167
Remote Messaging Server Properties dialog 

box, 189
Spoken Name Recorded

Prime Switch Location Properties dialog box, 
174

Remote Prime and Satellite Switch Location 
Properties dialog boxes, 198

Remote Satellite Switch Location Properties 
dialog box, 208

Standard Stale Time, 142

U
Urgent Stale Time, 142
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Numerics
120-Minute Messages��65

A
access code, ESN��178
access to OM reports��244
Acknowledgment Tag��64
adding and configuring a remote site��186��257

information required��186
main steps��186

Administrator-Recorded Personal Verification��

64
AMIS 1 tab, Message Delivery Configuration 

dialog box��139
AMIS 2 tab, Message Delivery Configuration 

dialog box��143��144
AMIS compose prefix

overview��81
selecting��145

AMIS Networking
compared with Integrated AMIS 

Networking��59
configuring��149
enabling functionality��149
implementation��72
Open AMIS boxes��135
parameters��80
relationship to Integrated AMIS��60

AMIS protocol��59
AMIS-A Networking. See AMIS Networking��

59
AMIS-A protocol��59
ANA (Analog Networking Agent)

description��87
function��91

Analog Messaging Agent. See ANA
as-required maintenance tasks��238

Audio Messaging Interchange Specification 
Networking. See AMIS Networking��
59

B
backing up Integrated AMIS Networking��71��

234
backup schedule��234
CallPilot backup��234
switch backup��234
types of backup��234

balancing channel resources��255
batch threshold

default value��136
description��77��141
impact of holding time��142

C
call routing test

evaluating result��224
procedure��224
purpose��222

Call Sender��63
call trace test

evaluating result��278
preliminary requirements��277
purpose��277

CallPilot
and Integrated AMIS Networking��58��63
backup��234
configuring��134

CDP dialing plan, configuration overview��181
CDP information

configuring��183
remote prime switch location��204

CDP steering code
overlap��182
overview��182

CDP tab
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Prime Switch Location Properties dialog box��

173
Remote Prime Switch Location Properties 

dialog box��196
Remote Satellite Switch Location Properties 

dialog box��207
channel resource allocation��255

determining if modifications are required��
255

minimum and maximum��121
modifying��255

channel types supported��120
checklist for gathering information��106
complex messaging network

implementation in��72
order of implementation��72

complex network��61
compose prefix

description��81
selecting��145

configuration errors��270
configuration, printing information��241
configuring

AMIS Networking��149
CallPilot for Integrated AMIS Networking��

70
CallPilot, main steps��134
CDP information��183
CDP information for a remote prime switch 

location��205
ESN information��180
local prime switch location, overview��171
local server, overview��166
local site, overview��164
message delivery parameters��147
non-CallPilot system as a remote site��215
remote messaging server��187��193
remote satellite switch location��209
remote satellite switch location, overview��

207
remote switch location, overview��196

configuring Integrated AMIS Networking
if other networking solutions are 

implemented��159
overview��135
preliminary requirement��134��137

required information��135
suggested process��137

configuring the switch, preliminary 
requirements��116

confirming switch settings��104
connection DN

function��84
modifying��261
relationship to system access number��83
remote messaging server��193

Connections tab, Remote Messaging Server 
Properties dialog box��192

controlled directory number (CDN) queues, 
types��128

coordinating information with remote sites��84
creating a diagram of messaging network��110
creating a loopback mailbox��153
creating a Restriction/Permission List��98
creating a spreadsheet of messaging network��

110

D
default value

batch threshold��136
delivery start time for economy messages��

136
delivery stop time for economy messages��

136
holding time for standard messages��136
holding time for urgent messages��136
parameters��76
reason to use��136
scheduling parameters��136
stale time for economy messages��136
stale time for standard messages��136
stale time for urgent messages��136

definition
integrated��60
Integrated AMIS Networking��58
network administrator��60
open��60
service directory number (SDN)��118

deleting
in multi-administrator environment��263
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remote messaging server��263
remote site��258��263
satellite switch location��263��265
several remote sites��264

delivery start and stop times, economy 
messages��145

delivery start time for economy messages��79
default value��136

delivery stop time for economy messages��79
default value��136

delivery times, Open AMIS��82
description��81

local server��167
diagram of how MTA and ANA handle 

messages��88
diagram of Integrated AMIS Networking��58
diagram of messaging network��110
dialing plan

CDP for remote prime switch location��204
CDP information��181
changing��108
ESN for remote prime switch location��201
ESN information��177
information for remote prime switch 

location��199
information required from switch��103
information required to configure switch 

location��174
local prime switch location��174
mailbox addressing follows��174
mailbox addressing follows for remote prime 

switch location��199
modifying��261��266
remote satellite switch location��208
requirements��108
used to dial a remote switch location��199

directory number (DN)
and switch��128
for Integrated AMIS Networking��128

disabling Integrated AMIS Networking��140��
250

other methods��251
DN. See directory number
dual-tone multifrequency tones��59

E
economy delivery start and stop times��79��81��

145
economy message

stale time��80
economy priority messages��75
Economy Tag��65
Electronic Switched Network. See ESN
enabling Integrated AMIS Networking��140��

167��250
other methods��251

end-to-end test
evaluating results��232
procedure��231
purpose��222

Enterprise Location ID
local prime switch location��173
remote prime switch location��198

Enterprise Networking
Enterprise Location ID��173��198
Enterprise Site ID��168
Names Across the Network��168
receiving message text information��169
sending message text information to a remo

site��191
Enterprise Site ID

description��168
modifying��261
remote messaging server��191

ESN
access code��178
location code��178
location code overlap��179

ESN dialing plan, configuration overview��177
ESN information, remote prime switch location��

201
ESN tab

Prime Switch Location Properties dialog box��

172
Remote Prime Switch Location Properties 

dialog box��196
Remote Satellite Switch Location Properties

dialog box��207
evaluating gathered information��108
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F
Failed Networking Sessions alert��244
Fax Call Answering CDN queues��128
fax channel type��120
features of Integrated AMIS Networking��63
Find key, using to locate item��259
finding a remote site��259
finding problem with Integrated AMIS 

Networking��270
FQDN of local server��169
FQDN of local SMTP/VPIM server��164

G
gathering information

checklist��106
evaluating��108
from open sites��102
from other sites��109
from switch��103
purpose��102
remote switch location checklist��107
required for network��69
required from switch��69��105
to implement Integrated AMIS Networking��

102
General tab

Prime Switch Location Properties dialog box��

172
Remote Messaging Server Properties dialog 

box��188
Remote Prime Switch Location Properties 

dialog box��197��207
Remote Switch Location Properties dialog 

box��196

H
hardware problems��271
header contents��74
holding time

description��77
interaction with batch threshold��142
relationship to stale time��142

standard messages��77��142
urgent messages��77��142

holding time for standard messages, default��136
holding time for urgent messages, default��136
how a message is transferred��92
how connection DNs work��84
how to

add and configure a new inbound service 
directory number (SDN)��125

configure a local prime switch location��175
configure a remote messaging server��193
configure a remote prime switch location��

200
configure a remote satellite switch location��

209
configure AMIS Networking��149
configure CDP information��183
configure CDP information for a remote 

prime switch location��205
configure ESN information��180
configure ESN information for a remote 

prime switch location��202
configure Integrated AMIS Networking 

parameters��147
configure the local messaging server��169
control exchange of open networked 

messages��97
create a loopback mailbox��153
delete a remote site��264
delete a satellite switch location��265
delete several remote sites��264
determine if Integrated AMIS Networking is 

disabled��272
disable Integrated AMIS Networking��251
enable Integrated AMIS Networking��251
import a spoken name��214
locate an item using Find��259
modify a remote site configuration��262
modify an SDN��256
modify dialing plan information��266
modify message delivery parameters��254
modify the Integrated AMIS Networking��

248
print configuration information��242
record a spoken name��212
set the default message priority��96
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share an existing inbound service directory 
number (SDN)��126

I
implementation

AMIS Networking��72
backup��71
configuring CallPilot��70
configuring the switch��70
creating messaging network representation��

70
gather information for network��69
main steps��69
overview��68
parameters set during��76
preliminary requirements��68
recommended order in complex messaging 

network��72
testing��71
validation��70

implementation order in complex messaging 
network��72

importing a spoken name��213��214
inbound service directory number (SDN)

how to add and configure new��125
how to share existing��126
services that can share��124
ways to set up��124

indicators in OM reports��274
information, gathering to implement Integrated 

AMIS Networking��102
Integrated AMIS Networking

and CallPilot��58
backing up information��71
compared with AMIS Networking��59
configuring a remote messaging server��193
configuring a remote prime switch location��

200
configuring a remote satellite switch location��

209
configuring CDP information��183
configuring CDP information for a remote 

prime switch location��205

configuring ESN information for a remote 
prime switch location��202

configuring parameters��147
configuring the local server��169
definition��58
determining if disabled��272
diagram��58
directory number��128
disabling��140��250
enabling��140��250
end-to-end test��222
features��63
gathering information��102
how it works��83
how to disable��251
how to enable��251
how to modify an SDN��256
how to modify message delivery parameters��

254
implementation in a complex messaging 

network��72
implementation overview��68
in complex network��61
information validation��70
internal controls��86
local site configuration��164
maintaining��238
message contents��74
message handling��74
modifying channel resource allocation��255
modifying configuration��246
modifying message delivery parameters��253
parameters��76
performing backups��234
phantom DN��129
preliminary requirements for configuration��

158
protocol used��59
relationship to AMIS��60
relevant OM reports��244
switch configuration required��116
switch requirements��116
switch settings required��108��128
switch-related problems��276
testing��71
troubleshooting, overview��270
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Integrated AMIS Networking test suite��222
call routing test��222
local or quick SDN test��222
loopback test��223

integrated, defined��60

L
legal delivery times for AMIS messages��82��

146
link diagnostic test��279
local AMIS system access number��140
local messaging server name��164
local prime switch location

configuration if NMS local site��171
configuration if other networking solution 

implemented��171
configuration overview��171
configuration procedure��175
description��173
dialing plan information��174
Enterprise Location ID��173
mailbox prefix��175
name��173
Prime Switch Location Properties dialog box��

172
recording spoken name��174

local SDN test
evaluating results��226
procedure��225
purpose��222

local server
configuration if another networking solution 

implemented��165
configuration overview��166
configuration process��169
description��167
FQDN��169
name��167
server type��167

local site name��164��167
local site, configuring��164
locating remote site��259
location code

ESN��178

overlap��179
loopback mailbox

creating��153
description��152
requirements��152
using��153

loopback test
evaluating results��230
procedure��229
purpose��223

M
mailbox addressing follows dialing plan, local 

prime switch location��174
mailbox addressing, dialing plan follows for 

remote prime switch location��199
mailbox prefix

local prime switch location��175
remote prime switch location��200

mailbox, loopback��152
main steps in implementation��69
maintenance

as-required tasks��238
backups following��239
overview��238
regularly scheduled tasks��238

Meridian Mail system, remote site��217
message

body contents��74
configuration for using priorities��75
handling scenario��92
header contents��74
parts��74
priorities��75
transfer process��92

Message Delivery Configuration dialog box
AMIS 1 tab��139
AMIS 2 tab��143��144
Standard stale time��141
Urgent stale time��141

message delivery parameters
configuring��147
overview��138
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message delivery parameters, modifying 
configuration��253

message handling��88
message priority, setting default��96
Message Subject (Text)��65
Message Transfer Agent (MTA), description��86
message transfer protocol, modifying��261
message transfer, main steps��87
messages sent while system disabled��250
Messaging Administration Properties dialog box

Networking Loopback Mailbox��152
messaging network��158
Messaging Network Configuration tree view, 

adding sites��158
messaging network representation��70

benefits��111
coordination with other sites��111
diagram��110
overview��110
security��111
spreadsheet��110

modifying
channel resource allocation��255
configuration of Integrated AMIS 

Networking��246
connection DN��261
dialing plan��261��266
Enterprise Site ID��261
Integrated AMIS Networking, announcing��

249
message delivery parameters��253
message transfer protocol��261
remote site��257

modifying remote site��257
configuration��260
impact��260
preliminary requirement��257

modifying remote site, impact on network 
database��258

MTA (Message Transfer Agent), description��86
MTA Monitor, description��87
multi-administrator environment, deleting items 

from tree view��263
Multiple Recipients��64

N
name

local prime switch location��173
remote prime switch location��197

Name Addressing��63
Name Dialing��63
name of a remote site��188
name of the local server��167
name of the local site��164
Names Across the Network��63��168
network administrator, defined��60
network database, impact of modifying remote

sites on��258
network history

contents��240
overview��240
security��240

network protocol used with a remote site��192
network representation

overview��110
using to add and configure a remote site��186

Network Usage Bill-back report��244
Networking Loopback Mailbox��152
networking solutions

configuration if implemented��159
order of implementation��72

NMS local site, configuring local prime switch 
location��171

NMS site
spoken name imported for��213
spoken name recorded for��211

non-CallPilot system
remote sites��215
server type��216

Norstar Voice Mail, remote site��218

O
OM reports

importance of reviewing��244
relevant for Integrated AMIS Networking��

244
restricted access��244

Open AMIS boxes on screens��135
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ox
Open AMIS compose prefix��81��145
Open AMIS delivery times��82��146
Open AMIS parameters��80
Open Networking Activity report��244
open, defined��60
order of implementation, recommended��72
outbound service directory number (SDN)��124
overlap

CDP steering code��182
ESN location code��179

P
parameters

AMIS Networking��80
default values��76
importance��80
Integrated AMIS Networking��76
overview��80
set during implementation��76

Personal Distribution Lists��63
phantom DN

how to select��129
relationship to service directory number 

(SDN)��120
required by Integrated AMIS Networking��

129
ways to create��130

prefix
compose��145
mailbox��175

Prime Switch Location Properties dialog box��

172
CDP tab��173
ESN tab��172
General tab��172
SMTP/VPIM tab��173

printing configuration information��241
priorities of messages��75
Private Tag��64
protocol, AMIS Networking��59
protocol, used with a remote site��192

Q
quick SDN test

evaluating results��227
procedure��227
purpose��222

R
Received Time Announced��65
receiving message text information��169
Recipient’s Name (Text)��65
recording a spoken name��212
regularly scheduled maintenance tasks��238
remote messaging server

configuration if another messaging solution 
implemented��187

configuration overview��187
connection DN��193
deleting��263
Enterprise Site ID��191
name��188
network protocol used��192
sending local user information to��190
sending message text information��191
sending messages to a remote site��189
server FQDN��191
server types supported��189

Remote Messaging Server Properties dialog b
Connections tab��192
General tab��188

remote prime switch location
CDP information��204
configuring��200
configuring ESN information��202
dialing plan for dialing to this location��199
dialing plan information��199
Enterprise Location ID��198
ESN information��201
mailbox addressing follows dialing plan��199
mailbox prefix��200
name��197
spoken name recorded��198

Remote Prime Switch Location Properties 
dialog box
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CDP tab��196
ESN tab��196
General tab��197
SMTP/VPIM tab��196
tabs��196

remote satellite switch location
configuration overview��207
configuring��209
dialing plan��208
spoken name recorded��208

Remote Satellite Switch Location Properties 
dialog box

CDP tab��207
ESN tab��207
tabs��207

remote site
adding��257
adding and configuring��186
adding, modifying, and deleting��257
coordinating information��84
deleting��258��263
how to delete��264
how to modify configuration��262
if other networking solutions implemented��

159
impact of modification��260
information required to add and configure��

186
locating��259
main steps to add and configure��186
Meridian Mail system��217
modifying��257
modifying configuration��260
name��188
non-CallPilot��215
Norstar Voice Mail system��218
using network representation to add and 

configure��186
Remote Site Spoken Names��64
remote switch location

configuration overview��196
information required��107
spoken name��211��213

Remote Switch Location Properties dialog box, 
General tab��196

Reply All��64

Reply To��64
reports for Integrated AMIS Networking��273
restricting message exchange��168
restricting sending messages to a remote site��

189
Restriction/Permission Lists

assigning for AMIS Networking��98
creating��98
purpose��98

reviewing Alarm and Event reports��273
reviewing OM reports��244

what to look for��274

S
satellite switch location

configuring remote��207
deleting��263

scheduling backups��234
SDN. See service directory number
Sender’s Department��65
Sender’s Name (Text)��65
sending local user information to a remote site��

190
sending message text information to a remote

site��191
sending messages to other sites��167
Sent Time Announced��65
server FQDN��169

local SMTP/VPIM server��164
remote site��191

server type
local server��167
non-CallPilot remote sites��216
supported for remote messaging server��189

service directory number (SDN)
adding and configuring new��125
and DN setting on switch��119
definition��118
examples��121
how to modify��256
inbound��118��124
outbound��118��124
relationship to other numbers��119
sharing existing inbound��126
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Service Directory Number (SDN) Table
description��118
example��119

Shared Distribution Lists��64
site status errors��271
SMTP/VPIM server FQDN��164
SMTP/VPIM tab

Prime Switch Location Properties dialog box��

173
Remote Prime Switch Location Properties 

dialog box��196
speech recognition channel type��120
Speech Recognition Messaging CDN queues��

128
spoken name

for remote switch location��211��213
importing��213��214
importing for local NMS site��213
recorded for remote satellite switch location��

208
recording��212
recording for local NMS site��211
recording for local prime switch location��174
recording overview��211

spoken name recorded
remote prime switch location��198
ways to record��198

spreadsheet of messaging network��110
stale time

description��78��141
relationship to holding time��142

stale time for economy messages, default��136
stale time for standard messages, default��136
stale time for urgent messages, default��136
standard message, holding time��77
standard priority messages��75
standard stale time��141
start and stop times, economy messages��81
steering code for CDP��182
switch

and directory numbers (DNs)��128
backup��234
configuration changes��266
configuring for Integrated AMIS 

Networking��70
confirming settings��104

dialing plan information required��103
gathering information��103
gathering information directly from��103
how an Integrated AMIS message is treated��

116
information required from��105
information to gather��69
Integrated AMIS Networking requirements��

116
mandatory requirements��108
setting required for Integrated AMIS 

Networking��128
switch-related problems��276

call trace��271
call trace test��277
link diagnostic test��279

system access number
coordinating information��84
private network��141
public network��140
purpose��140
relationship to connection DN��83

T
terms used in this guide��60
test suite

call routing test��222
end-to-end test��222
local SDN test��222
loopback test��223
purpose��222
quick SDN test��222
tests included��222

testing Integrated AMIS Networking��71
compliance of third-party systems��222
coordination required��223
ensuring quick results��223

testing with loopback mailbox��153
text information in messages��169
third-party systems, testing compliance��222
Timed Delivery��65
tree view, deleting items from��263
troubleshooting Integrated AMIS Networking

configuration errors��270
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hardware problems��271
identifying problem��270
overview��270
site status errors��271
switch-related problems��271

U
urgent messages��75

holding time��77
Urgent stale time��141
Urgent Tag��64
User’s Actual Personal Verification��64
using a loopback mailbox��153

V
validation of information��70
Virtual Node AMIS, terminology note��215
virtual node, replaced by integrated��60
voice channel type��120
Voice Messaging CDN queue��128
VPIM Networking, server FQDN of remote site��

191

W
ways to disable Integrated AMIS Networking��

251
ways to enable Integrated AMIS Networking��

251
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